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In This Book
This book is your guide to programming Keysight DigitalTestApps.

• Chapters 1-4 describe how to use an existing remote client:

• Chapter 1, “Keysight DigitalTestApps Remote Interface,” starting on page 9.

• Chapter 2, “Using Sample Remote Clients,” starting on page 15.

• Chapter 3, “Remote Programming Languages and Sample Code,” starting 
on page 37.

• Chapter 4, “Recommended Remote Programming Practices,” starting on 
page 71.

• Chapter 5, “Developing a Remote Client,” starting on page 77, describes how 
to create new remote clients.

• Chapter 6, “Troubleshooting,” starting on page 125, lists common problems 
and resolutions.

How to use this
book

Start by reading the Keysight DigitalTestApps Programming Getting Started guide; 
then, read all the chapters in this guide in order.
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1 Keysight DigitalTestApps 
Remote Interface

Remote Interface Documentation / 10
.NET Interface / 12
LabVIEW Interface / 14

This chapter describes the fundamentals of the Keysight DigitalTestApps Remote 
Interface. If you haven't done this already, please read the Getting Started guide 
for important information needed to use this Programming Guide more effectively.

Whether you're using an existing remote client or developing your own, you need 
the following information to understand how to send instructions to the 
automated test application.

There are two basic types of commands: properties and methods.

• Properties represent data values in the automated test application. They can be 
read (query value) and in some cases written to (set value).

• Methods are functions which the automated test application can execute. They 
may require input parameters and/or provide return values.

In addition, some property actions and method calls use custom types defined by 
the automated test application. Custom types are classes containing the required 
data.
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Remote Interface Documentation

Besides the Guide you are currently reading, there are other important documents 
which describe aspects of the Keysight DigitalTestApps Remote Interface:

In the Toolkit The following document is located in the base folder of the Automated Test 
Application Remote Development Toolkit:

• Keysight_DigitalTestApps_Programming_Getting_Started.pdf

The following documents are located in the two "Documents" subfolders of the 
Automated Test Application Remote Development Toolkit:

• Keysight DigitalTestApps Remote Interface for .NET.chm.

• Keysight DigitalTestApps Remote Interface for LabVIEW.chm.

The .chm files describe each of the elements of the remote interface, including 
properties, methods, types, etc.

On the Server The following application-specific document is located in the "help" folder of the 
automated test application's installation directory. For automated test apps that 
run directly on an oscilloscope, this folder may be found in either of these 
locations:

c:\Program Files\Agilent _or_ Keysight\Infiniium _or_
FlexDCA\Apps\(application name)\help\(application
name)_Remote_Prog_Ref.chm (or .pdf)

- Or -
(Infiniium real-time on WinXP only) c:\scope\apps\(application

name)\help\(application name)_Remote_Prog_Ref.chm (or .pdf)

For automated test applications that run on a separate PC, this folder may be 
found in:

c:\Program Files\Agilent _or_ Keysight\Infiniium _or_
FlexDCA\Apps\(application name)\help\(application
name)_Remote_Prog_Ref.chm (or .pdf)

- Or -
(Infiniium real-time only)

c:\Program Files\Keysight\Scope\Apps\(application
name)\help\(application name)_Remote_Prog_Ref.chm (or .pdf)

NOTE Please see the readme.txt files located in the "Agilent-Keysight Transition" and "Keysight Apps 
Only" subfolders for guidance on which location to use.

NOTE For Windows 7, substitute "Program Files (x86)" for "Program Files".
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This help file (.chm or .pdf) describes application-specific configuration variable 
names and values, test names and IDs, and external instrument names. These are 
used as parameters or returned as results by various elements of the Keysight 
DigitalTestApps Remote Interface. The .Net.chm and LabVIEW.chm help files 
(described above) refer you to this application-specific document in their 
descriptions of remote interface elements that require application-specific values. 
You may view the remote interface help file(s) through the application's Help > 
Remote Interface menu (applications supporting remote interface version 2.00 or 
later, only).

In the User
Interface

You may also obtain remote interface help directly from the application's user 
interface (applications supporting remote interface version 1.20 or later, only). 
Simply enable the "show remote interface hints" user preference (menu: 
View->Preferences :: Remote tab). If there is a remote command that can be used to 
accomplish an element's function, it can be found this way:

NOTE The LabVIEW remote interface is a wrapper around the .NET remote interface. The help topics 
in the LabVIEW.chm contain links to their associated .NET.chm topics, which often provide 
additional information about the feature. When using the LabVIEW.chm, keep in mind that the 
elements designed for LabVIEW use are located in namespace 
Keysight.DigitalTestApps.RemoteTestClient, while those found in the 
Keysight.DigitalTestApps.Framework namespaces are for .NET cross-reference use.

User Interface Element Hint Location

Toolbar Click a toolbar button.

Set Up tab
Run Tests tab
Resul ts tab
Various run-time dialogs

Right click a control and select Remote Interface Hint.

Select Tests tab Select a test (by clicking on its name) and check the description 
pane at the bottom of the tab.

Configure tab Select a configuration item and check the description pane on the 
right side of the tab.

TIP To find out what version of the remote interface an application supports, check its Help > 
About screen (if it does not appear there, the version is older than 1.20).
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.NET Interface

The elements of the .NET interface are contained in a library named 
Keysight.DigitalTestApps.Framework.Remote.dll and are divided into three 
namespaces:

• “Keysight.DigitalTestApps.Framework.Remote" on page 12

• “Keysight.DigitalTestApps.Framework.Remote.Advanced" on page 12

• “Keysight.DigitalTestApps.Framework.Remote.Exceptions" on page 13

Keysight.DigitalTestApps.Framework.Remote

This namespace contains the core remote interface features. A good starting place 
to look at is the RemoteAteUtilities class, which contains the methods used to 
connect to the automated test application, and the IRemoteAte interface, where 
most of the commands you will use are found.

The features in this namespace involve the remote client initiating some action and 
the automated test application responding, making use of the "remote client -> 
automated test app path" of the remote interface.

For example, to execute a remote interface method:

1 The client computer initiates the action (the method call).

2 The .NET Remoting layer transports the request to the server (the application 
running on oscilloscope or PC).

3 The application executes the method and generates the return value.

4 The .NET Remoting layer transports the return value to the client.

Keysight.DigitalTestApps.Framework.Remote.Advanced

This namespace contains advanced programming features. The most important 
member is the AteEventSink, where most of the advanced commands you will use 
are found.

Some of the features in this namespace involve the automated test application 
initiating some action and the remote client responding, making use of the 
"automated test app -> remote client callback path" of the remote interface.

For example, one of the advanced features involves the ability to force dialogs that 
would normally display on the oscilloscope to display on the client instead. In this 
case:

1 The server (the application running on oscilloscope or PC) initiates the action 
(generates a message).

2 The .NET Remoting layer transports the message to the client computer.

3 The client displays the message and generates a response ("OK", "Cancel", etc.)
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4 The .NET Remoting layer transports the response to the server.

Keysight.DigitalTestApps.Framework.Remote.Exceptions

This namespace contains remote interface-specific exception types that may be 
thrown during a remote operation.
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LabVIEW Interface

The elements of the LabVIEW interface are contained in a library named 
Keysight.DigitalTestApps.RemoteTestClient.dll. This library contains methods that 
wrap access to the properties and methods of the .NET interface.
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2 Using Sample Remote Clients

ARSL Command Line Utility / 16
Simple GUI Remote Client / 18
Message Handling Remote Client / 22
Simple Message Handling Remote Client / 20
LabVIEW Simple Remote Client / 25
LabVIEW Demo Remote Client / 29

This chapter describes a set of ready-to-run sample remote clients that you can 
use to explore the Keysight DigitalTestApps Remote Interface.
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ARSL Command Line Utility

The easiest way to try out the remote interface is by using a simple command-line 
remote client. This client lets you use plain text to execute the commands found in 
the .NET remote interface, which is described in Chapter 1, “Keysight 
DigitalTestApps Remote Interface,” starting on page 9.

To use this utility:

1 Using Windows Explorer, browse to the toolkit installation directory.

2 In the desired "Tools\C#" subdirectory, locate the "ARSL Command Line Utility" 
folder. Copy its contents to a new folder on your computer.

3 Copy the application file Keysight.DigitalTestApps.Framework.Remote.dll (or 
Agilent.Infiniium.AppFW.Remote.dll, see "On the Client" in the Keysight 
DigitalTestApps Programming Getting Started guide) to this new folder as well.

4 The folder on your computer should now look like this:

5 Now open a Windows command prompt and browse to the folder you created:

6 Ensure your configuration meets the requirements listed in "On the Server" in 
the Keysight DigitalTestApps Programming Getting Started guide, including 
launching the automated test application on the server.

7 Get the IP address of the target machine running the automated test 
application (oscilloscope or PC). On Windows-based machines, this may be 
obtained by typing "ipconfig" in a Command Prompt window.

8 Enter this in your Command Prompt window and press <enter>:

arsl -a 123.45.67.89 -c ApplicationName?

(substitute your actual IP address for 123.45.67.89)

NOTE Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps 
only" subdirectories for guidance on the files to use for your remote client.
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9 Observe the automated test application's response. In the example above, an 
application named Reference Application responded with "RefApp Test".

You may also use this utility to execute scripts. An example, "SampleScript.txt" is 
included with the executable. Execute the script by entering this:

arsl -a 123.45.67.89 -s SampleScript.txt

(substitute your actual IP address for 123.45.67.89)

The command "ApplicationName?" and the contents of the file "SampleScript.txt" 
are examples of Keysight Automated Test Engine Remote Scripting Language 
(ARSL) commands. ARSL is described in more detail in "The Automated Test 
Remote Scripting Language (ARSL)" on page 38.

Note: To see all available options, enter this:

arsl -h



18 Keysight DigitalTestApps Programming Guide

2 Using Sample Remote Clients
 

Simple GUI Remote Client

To see how a graphical user interface-based approach can work, try this client.

To use the simple GUI remote client:

1 Using Windows Explorer, browse to the toolkit installation directory.

2 In the desired "Tools\C#" subdirectory, locate the folder named "Simple GUI 
Remote Client". Copy its contents to a new folder on your computer.

3 Copy the file Keysight.DigitalTestApps.Framework.Remote.dll (or 
Agilent.Infiniium.AppFW.Remote.dll, see "On the Client" in the Keysight 
DigitalTestApps Programming Getting Started guide) to this new folder as well.

The folder on your computer should now look like this:

4 Ensure your configuration meets the minimum requirements listed in "On the 
Server" in the Keysight DigitalTestApps Programming Getting Started guide.

5 Get the IP address of the target machine running the automated test 
application (oscilloscope or PC). On Windows-based machines, this may be 
obtained by typing "ipconfig" in a Command Prompt window.

6 Now execute the file SimpleGuiRemoteClient.exe. When the main dialog 
displays, follow the steps to run a test.

NOTE Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps 
only" subdirectories for guidance on the files to use for your remote client.
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Simple Message Handling Remote Client

Now take a look at a client that demonstrates basic message handling capabilities 
of the remote interface.

To use the simple message handling remote client:

1 Using Windows Explorer, browse to the toolkit installation directory.

2 In the desired "Tools\C#" subdirectory, locate the folder named "Simple 
Message Handling Remote Client". Copy its contents to a new folder on your 
computer.

3 Copy the files Keysight.DigitalTestApps.Framework.Remote.dll and 
Keysight.DigitalTestApps.Framework.Remote.config (or 
Agilent.Infiniium.AppFW.Remote.dll and 
Agilent.Infiniium.AppFW.Remote.config, see "On the Client" in the Keysight 
DigitalTestApps Programming Getting Started guide) to this new folder as well.

The folder on your computer should now look like this:

4 Ensure your configuration meets the minimum requirements listed in "On the 
Server" in the Keysight DigitalTestApps Programming Getting Started guide.

5 Now execute the file SimpleMessageHandlingRemoteClient.exe:

6 When the main dialog displays, enter the IP address of the target machine 
running the automated test application (oscilloscope or PC). On 
Windows-based machines, this may be obtained by typing "ipconfig" in a 
Command Prompt window.

NOTE Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps 
only" subdirectories for guidance on the files to use for your remote client.
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7 Click "Connect".

8 Enter a test ID. See Chapter 1, "Remote Interface Documentation" on page 10, 
for more information on getting your application's test IDs.

9 Click "Run".

The rest of the dialog presents options for using the remote interface to manage 
messages that the remote application displays:

• Redirect app messages to remote cl ient

When checked, the automated test application will not display messages on 
the oscilloscope. Instead, messages will be displayed on the client PC using a 
default display algorithm provided by the 
Keysight.DigitalTestApps.Framework.Remote DLL.

• Handle simple callbacks programmatically

When checked, the default algorithm used in the "Redirect" option above will 
be replaced by a custom algorithm defined in the Simple Message Handling 
Remote Client program for "simple" messages (those not requiring value entry).

NOTE If you close and relaunch the automated test application, it will initialize with default settings, 
such as Redirect=false. In this case, you should close and relaunch the simple message 
handling client to reinitialize it as well.
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Message Handling Remote Client

Now take a look at a client that demonstrates advanced message handling 
capabilities of the remote interface.

To use the message handling remote client:

1 Using Windows Explorer, browse to the toolkit installation directory.

2 In the desired "Tools\C#" subdirectory, locate the folder named "Message 
Handling Remote Client". Copy its contents to a new folder on your computer.

3 Copy the files Keysight.DigitalTestApps.Framework.Remote.dll and 
Keysight.DigitalTestApps.Framework.Remote.config (or 
Agilent.Infiniium.AppFW.Remote.dll and 
Agilent.Infiniium.AppFW.Remote.config, see "On the Client" in the Keysight 
DigitalTestApps Programming Getting Started guide) to this new folder as well.

The folder on your computer should now look like this:

4 Ensure your configuration meets the minimum requirements listed in "On the 
Server" in the Keysight DigitalTestApps Programming Getting Started guide.

5 Get the IP address of the target machine running the automated test 
application (oscilloscope or PC). On Windows-based machines, this may be 
obtained by typing "ipconfig" in a Command Prompt window.

6 Now execute the file MessageHandlingRemoteClient.exe, passing in the IP 
address of the remote application as the first parameter:

7 When the main dialog displays, enter a test ID. See Chapter 1, "Remote 
Interface Documentation" on page 10, for more information on getting your 
application's test IDs.

NOTE Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps 
only" subdirectories for guidance on the files to use for your remote client.
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8 Click "Run".

The rest of the dialog presents options for using the remote interface to manage 
messages that the remote application displays:

The following options use core remote interface features:

• Suppress simple messages

When checked, the remote application will not display application-specific 
"simple messages". These are defined as messages that use only the standard 
Microsoft button responses, for example, OK/Cancel, Yes/No, etc., and do not 
require the user to enter any values. When the application needs to display a 
simple message, it will instead automatically respond to it with a 
predetermined default button selection.

• Suppress data input messages

When checked, the remote application will not display application-specific 
"data input" messages. These are defined as messages that require the user to 
enter a single alphanumeric value. When the application needs to display a 
data input message, it will instead attempt to automatically respond to it with a 
predetermined value. In cases where the automated test application has no 
automatic response, the test will abort.

• Action to take for "Connect" prompt:

This combo box presents three options that affect what happens when the 
remote application needs to display the standard "Change Physical 
Connection/Setup" dialog:

• Abort — When this option is selected, the remote application will throw an 
exception.

• AutoRespond — When this option is selected, the remote application 
suppresses the dialog and assumes you have made the connection.

• Display — When this option is selected, the remote application will display 
the dialog.
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• Action to take for "CheckSignal" prompt:

This combo box presents three options that affect what happens when the 
remote application needs to display the standard "Check Signal" dialog:

• Abort — When this option is selected, the remote application will throw an 
exception.

• AutoRespond — When this option is selected, the remote application 
suppresses the dialog and assumes the signal is acceptable.

• Display — When this option is selected, the remote application will display 
the dialog.

The following options use advanced remote interface features:

• Redirect messages to cl ient

When checked, the remote application will not display any of the above 
message types on the oscilloscope. Instead, the message will be displayed on 
the client PC using a default display algorithm provided by the 
Keysight.DigitalTestApps.Framework.Remote DLL.

• Override defaul t message handler

When checked, the default algorithm used in the "Redirect" option above will 
be replaced by a custom algorithm defined in the Message Handling Remote 
Client program.

The Core Feature options override the Advanced options. Thus, the application will 
not redirect simple messages to the client if they are being suppressed.

NOTE If you close and relaunch the automated test application, it will initialize with default settings, 
such as suppress=false. In this case, you should close and relaunch the message handling 
client to reinitialize it as well.
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LabVIEW Simple Remote Client

Now take a look at a simple remote client that demonstrates the use of the 
LabVIEW programming environment to control an automated test application. See 
"On the Client" in the Keysight DigitalTestApps Programming Getting Started 
guide for a list of minimum requirements.

1 Using Windows Explorer, browse to the toolkit installation directory that 
corresponds to the remote interface version supported by the automated test 
application you wish to control.

2 In the "Agilent-Keysight Transition\Source" subdirectory, locate the "LabView\
Simple Client" folder. Copy its contents to "C:\LabView" on your computer.

3 In the "Agilent-Keysight Transition\Tools" subdirectory, locate the "LabView 
Remote Adapter" folder. Copy its contents to "C:\LabView".

4 Copy the application file Agilent.Infiniium.AppFW.Remote.dll (see "On the 
Client" in the Keysight DigitalTestApps Programming Getting Started guide) to 
"C:\LabView".

5 The folder on your computer should now look like this:

6 Ensure your configuration meets the minimum requirements listed in "On the 
Server" in the Keysight DigitalTestApps Programming Getting Started guide.
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7 Get the IP address of the target machine running the automated test 
application (oscilloscope or PC). On Windows-based machines, this may be 
obtained by typing "ipconfig" in a Command Prompt window.

8 Open the file "SimpleRemoteClientProject.lvproj".

9 In the LabView Project Explorer, open the file "SimpleRemoteClient.vi".

10 Before launching the example program, the path for the working directory 
needs to be changed. Change the path to point to the directory where both the 
Agilent.Infiniium.AppFW.Remote.dll and Agilent.Infiniium.RemoteTestClient.dll 
are located.

11 Change the IP to point to the scope where the automated test application is 
running.
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12 Launch the program. You should see the following screen:

13 Click Connect.
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14 Enter the ARSL Command string.

15 Click Execute ARSL.

Observe the indicator for the status/return value of the ARSL Command 
executed.
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LabVIEW Demo Remote Client

Now take a look at a more advanced client that demonstrates the use of the 
LabVIEW programming environment to control an automated test application. See 
"On the Client" in the Keysight DigitalTestApps Programming Getting Started 
guide for a list of minimum requirements.

1 Using Windows Explorer, browse to the toolkit installation directory that 
corresponds to the remote interface version supported by the automated test 
application you wish to control.

2 In the "Agilent-Keysight Transition\Source" subdirectory, locate the "LabView\
Demo Client" folder. Copy its contents to "c:\LabView" on your computer.

3 In the "Agilent-Keysight Transition\Tools" subdirectory, locate the "LabView 
Remote Adapter" folder. Copy its contents to "c:\LabView".

4 Copy the application file Agilent.Infiniium.AppFW.Remote.dll (see "On the 
Client" in the Keysight DigitalTestApps Programming Getting Started guide) to 
"c:\LabView".

5 The folder on your computer should now look like this:

6 Ensure your configuration meets the minimum requirements listed in "On the 
Server" in the Keysight DigitalTestApps Programming Getting Started guide.
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7 Get the IP address of your oscilloscope. This may be obtained by displaying the 
"GPIB Setup" dialog via the "Utilities" menu on the oscilloscope.

8 Open the file "Example Labview Remote Client.lvproj".

9 In the LabView Project Explorer, open the file "Main Interface.vi".

10 Before launching the example program, the path for the working directory 
needs to be changed. Change the path to point to the directory where both the 
Agilent.Infiniium.AppFW.Remote.dll and Agilent.Infiniium.RemoteTestClient.dll 
are located.

11 Launch the program. You should see the following screen:
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Connecting to the Automated Test Application

Enter the IP address of the oscilloscope where the Automated Test Application is 
running; then, click Connect.
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Selecting/Running Tests

Select the tests to run from the list box; then, click Run to start the tests. If you 
select multiple tests, they will run one after another. The list of available tests 
depends on the current configuration setting.

The number of trials to run for the selected tests can be changed via the spinner 
control.

Click Refresh Test List to update the choice of tests available.

Test Plans When a remote application supports the Test Plan feature, check Enable Test Plans 
to run the tests with it. Check Skip Completed Permutations to skip all completed 
permutations of the Test Plan feature.

Results Select the preferred Store Mode for keeping track of the test results such as worst 
trials, best trials, last N trials, and events. Existing test results may be Replaced or 
have new results Appended to them. Refer to "Keysight DigitalTestApps Remote 
Interface for .NET.chm" for more details on the different store modes available.

Events In order for the application to react to a particular event of interest, check On Event 
and select the action to be taken when that event occurs. Select the Event of 
interest, there can be up to 2 events at a time. The choice of the 1st event would 
affect what is available as the 2nd choice. Note that certain events are only 
applicable to specific automated test applications.

E-mail Check Send Email to enable email sending when tests have completed execution or 
aborted.
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Set/Get Configuration

To set an automated test application configuration value, enter the "Configuration 
Name" and "Configuration Value" in the appropriate text boxes and click Set 
Configuration.

To get a configuration value from the automated test application, enter the 
Configuration Name in to the appropriate text box and click Get Configuration. The 
value for that variable will be displayed in the "Configuration Value" text box.

Refer to the individual automated test applications and framework guide for the 
available configurations.

Select the preferred action to be taken whenever the application requests for a 
change in the physical set up. Refer to "Keysight DigitalTestApps Remote Interface 
for .NET.chm" for more details on the individual actions.

Select the preferred action to be taken whenever the application checks the signal 
before execution of a test. Refer to "Keysight DigitalTestApps Remote Interface for 
.NET.chm" for more details on the individual actions.
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Obtaining Results

Select the tests from the list box, and click Get Test Resul ts to view the results. The 
results will be displayed in the following table:

The following attributes are displayed for each selected test:

1 Status – Pass / Fail.

2 Test Name.

3 Test ID.

4 Trial Number.

5 Parameter that was measured.

6 Value of the measurement.

7 Passing margin.

If a test with no result is selected, the "Parameter Name" column displays "No 
Results".
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Deleting Results

To delete all the results for all tests, click Delete Resul ts.

Saving/Loading Projects

To save a project, enter the full path of the location on the oscilloscope, for 
example, C:\TestData\USB\GenericHubDevice; then, click Save Project. The project 
is called "GenericHubDevice" and saved at "C:\TestData\USB\ 
GenericHubDevice". Note that this saves the project on the oscilloscope. Checking 
Overwrite Existing Project causes a project already saved with the same name to be 
overwritten.

To load the project saved in the example above, the path would be "C:\TestData\
USB\GenericHubDevice\GenericHubDevice". Click Load Project to load a previously 
saved project. Checking Discard Unsaved Changes loads the selected project, 
ignoring all previously unsaved changes for the current project.

To create a new project, click New Project. Checking Discard Unsaved Changes creates 
a new project ignoring all the previously unsaved changes for the current project.
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ARSL

Enter the ARSL command and click Execute ARSL. The results are displayed in the 
ARSL Status box.

Compliance Limit Set

Select the Limit Set Type of choice and provide the Limit Set Name and Limit Set Path 
(the path setting is only applicable for UserDefined limits). Check Discard Confl icting 
Resul ts to remove all conflicting results when a limits set is activated.
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Python / 55

This chapter describes some of the languages you may use to program an 
automated test application, and provides code snippets to demonstrate language 
use.
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The Automated Test Remote Scripting Language (ARSL)

Sometimes it is more convenient to access the automated test application remote 
interface using a textual syntax rather than the standard property/method call 
syntax. This is possible by using a command language called the Automated Test 
Engine (ATE) Remote Scripting Language, or "ARSL". The ARSL Command Line 
Utility (described in "ARSL Command Line Utility" on page 16) takes advantage of 
this capability to present an easy-to-use textual interface to an automated test 
application.

The ARSL interface is implemented by using a method provided by the standard 
.NET remote interface: "ExecuteArsl()". This method takes one parameter: the 
textual remote interface command.

Here are some C# examples:

// Get ATE remote interface object
IRemoteAte remoteAte = RemoteAteUtilities.GetRemoteAte(ipAddress);

// Perform the property query "ApplicationName"
string appName = remoteAte.ExecuteArsl("ApplicationName?");

// Perform the method call "SetConfig(variable,value)"
remoteAte.ExecuteArsl("SetConfig Speed Fast");

The argument in the ExecuteArsl call is the ARSL command. Remote interface 
members may be translated into ARSL using the following conversion rule map:

In ARSL, property set and method call arguments are separated by spaces. If the 
argument contains reserved characters (spaces, single quotes, or double quotes), 
you must surround the value accordingly:

Action .NET Syntax ARSL Syntax

Property query var = PropertyName; PropertyName?

Property set PropertyName = val; PropertyName val

Method call MethodName(arg1,arg2); MethodName arg1 arg2

Argument Legal ARSL formats

Ab Ab
'Ab'
"Ab"

A b 'A b'
"A b"

A'b "A'b"

A"b 'A"b'
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You can also use ARSL to set properties whose types are custom types and to call 
methods that take custom type parameters:

PropertyName "property1=value;property2=value"
MethodName "property1=value;property2=value"

This technique results in the following:

1 An object of the type required by the property or method is created

2 The object is modified by setting the its specified properties to the specified 
values

3 The modified object is then used to set the property or is passed to the method.

The following examples should make this more clear:

.NET Syntax
------------------
SomeOptions options = new SomeOptions();
options.Option1 = "a";
options.Option2 = "b";
remoteAte.Foo(options);

ARSL Syntax
-------------------
Foo Option1=a;Option2=b

The ARSL parser will automatically detect that Foo requires a parameter of type 
SomeOptions and will then construct one. It will then set the two specified 
properties on the SomeOptions object and finally pass this object as a parameter 
to the Foo method.

Note that, in this syntax, multiple property sets are separated by a semicolon. In 
the example above, the option set statements did not contain any spaces, so the 
pair did not need to be enclosed in quotes.

In the examples below, the option set statements contain a space and thus need to 
be enclosed in quotes:

Foo 'Option3=A b'
Foo "Option3=A b"
Foo "Option1=A b;Option2=c"

Example Code

The following ARSL code snippets demonstrate property actions and method 
invocations:

# Property actions
# ----------------

# Read the remote interface version
RemoteInterfaceVersion?

# Prevent these dialogs from displaying during run
SuppressSimpleMessages true
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# Method invocations
# ------------------

# Set one of the application's user-configurable options
SetConfig speed fast

# Save the current configuration
SaveProject myProjectName

In addition, some property actions and method calls use custom types defined by 
the automated test application. Custom types are classes containing the required 
data. The following code snippets are examples of this:

# Custom property types
# ---------------------

# Query
ExistingResultsAction?

# Set
ConnectionPromptAction AutoRespond

# Custom types used in methods
# ----------------------------
SaveProjectCustom "Name=MyProject;BaseDirectory=d:\
MyProjects;OverwriteExisting=true"

GetResults

Common Tasks

Here are common tasks you may want to perform in your programs. When there is 
more than one way to accomplish the task, alternatives are listed with a usage 
hint. For more information on each of the commands mentioned below, see the 
help file, "Keysight DigitalTestApps Remote Interface for .NET", located in the 
same directory as this programming guide.

• "Launching the automated test app" on page 41

• "Suppressing message prompts" on page 41

• "Configure settings found on the application's 'Set Up' and 'Configure' tabs" 
on page 41

• "Select tests to be run" on page 42

• "Run Tests" on page 42

• "Get Results" on page 42

NOTE If a method demonstrated below does not enable you to customize the action as desired, 
check the command help file to see if there is a similarly named "XxxCustom" method that 
provides more flexibility.
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• "Save the project" on page 42

• "Start a new project" on page 43

• "Open a project" on page 43

• "Exiting the automated test app" on page 43

Launching the automated test app

• Manually. Use any time.

Infiniium automated test apps: Use the oscilloscope menu: Analyze > Automated 
Test Apps > (AppName)

FlexDCA automated test apps: Use the oscilloscope menu: Apps > Automated 
Test Apps > (AppName)

Automated test apps: On your PC, launch the app using the Start menu or a 
shortcut.

• Using remote command. Send this SCPI command to Infiniium or FlexDCA:

:SYSTEM:LAUNCH 'AppName'

Where AppName is the name exactly as it appears in the menu system (see 
alternative above).

Suppressing message prompts

• Suppress "OK button" message prompts of type "Info", "Warning", or "Error". 
Use any time.

SuppressSimpleMessages true

• Suppress "OK/Cancel button" messages that ask you to enter a value. Use only 
if the application has defined a default value for that prompt; otherwise test will 
be aborted.

SuppressDataInputMessages true

• Suppress connection prompts. Use any time.

ConnectionPromptAction AutoRespond

• Suppress "Signal Missing" prompts. Use any time.

SignalCheckFailAction AutoRespond

• Suppress all of the above. See above for appropriate usage.

SuppressMessages true

Configure settings found on the application's 'Set Up' and 'Configure' tabs

SetConfig 'variableName1' 'value1'
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Select tests to be run

• Select all of the tests currently shown on the application's 'Select Tests' tab. 
Use any time.

SelectAllTests

• Select a subset of the available tests. Use any time.

SelectedTests = 123,456,etc.

Run Tests

• With defaults. Use any time.

Run

• With options. Use when you want to override the user preferences currently 
active in the target application.

RunCustom 'StopRunIfTestAborts=true'

Get Results

• Quick overall result. Use any time.

Passed?

• Get full details for all existing test results. Use any time.

GetResults

• Get a subset of all available results. Use any time.

GetResultsCustom 'TestIds=123,456;IncludeCsvData=true'

• CSV report. Use when you want CSV results in a separate file. File "results.csv" 
will be located inside the project.

ExportResultsCsv
SaveProject 'Project1'

• CSV text. Use when you want to see the CSV results on the remote client.

GetResultsCustom 'IncludeCsvData=true'

• HTML Report.

The .html file is located in the saved project.

Save the project

• Using default location property. Use when that location does not already have a 
project by the same name (although re-saves to the same location are allowed).

SaveProject 'Project1'

• Using options. Use any time.
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SaveProjectCustom Name=Project1;BaseDirectory=c:\...\
MyProjectDir;OverwriteExisting=true'

Start a new project

• Checking method. Use when you want to be warned when unsaved results 
exist.

NewProject false

• Forced method. Use when you always want this command to complete 
(unsaved results will be discarded).

NewProject true

Open a project

• Using default location. Use when you want to be warned when unsaved results 
exist.

OpenProject 'Project1'

• Using options. Use any time.

OpenProjectCustom 'FullPath=c:\...\MyProjectDir\
Project1;DiscardUnsaved=true'

Exiting the automated test app

• Safer method. Use when you do not want to risk losing unsaved results (action 
will fail if unsaved results exist).

Exit false true

• Forced method. Use when you always want this command to complete 
(unsaved results will be discarded).

Exit true true

Example Program

SuppressMessages true
NewProject true
ExistingResultsAction Append
SelectedTests 123
Run
SaveProjectCustom 'Name=MyProjectName;OverwriteExisting=true'

See Chapter 1, "Remote Interface Documentation" on page 10, for more 
information on getting your application's test IDs.

NOTE Replace 123 with actual test ID for your application.
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Advanced Topic: Switch Matrix

The following ARSL code snippets demonstrate how to configure the Switch Matrix 
controller.

Using Automatic Mode

SwitchMatrixOn true
SwitchMatrixSelectModeAuto 'Keysight U3020A S26'
SwitchMatrixConnectToInstrument 1 'lan[123.456.7890]:inst0'

If additional drivers were created by the app during execution of 
SwitchMatrixSelectModeAuto, simply execute 
SwitchMatrixConnectToInstrument again for each driver ID and instrument 
address. Each driver must be connected to a separate switch matrix instrument.

Using Manual Mode

SwitchMatrixOn true
SwitchMatrixSelectModeManual
SwitchMatrixAddDriver 'Keysight U3020A S26'
SwitchMatrixConnectToInstrument 1 'lan[123.456.7890]:inst0'

To create an additional driver, simply add these lines:

SwitchMatrixAddDriver 'Keysight U3020A S26'
SwitchMatrixConnectToInstrument 2 'lan[123.456.7890]:inst0'

Each driver must be connected to a separate switch matrix instrument.

Now you need to manually define each signal path, each one starting from the test 
point on the Device Under Test, through the switch, and ending with the scope 
channel.

Here is an example of a single-ended signal going into scope channel 3:

SwitchMatrixDefineSignalPath 'CLK' 'Driver=1;Slot=1;Input=1' '3'

Here is an example of a differential signal going into a differential probe connected 
to scope channel 4:

SwitchMatrixDefineSignalPath 'Strobe+' 'Driver=1;Slot=1;Input=1' '4+'
SwitchMatrixDefineSignalPath 'Strobe-' 'Driver=1;Slot=2;Input=1' '4-'

NOTE Replace 123.456.7890 with the full SICL address or VISA alias of your switch instrument.

NOTE Replace 123.456.7890 with the full SICL address or VISA alias of your switch instrument.
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Using Either Mode

All that remains is to assign a correction method to each signal path. This is 
optional but highly recommended.

Here is an example for one signal path that is using a single-ended probe:

SwitchMatrixSetPathPrecisionProbe 'CLK' '3' 'On=True;Mode=Probe;Calibrat
ion=MyCalName'

Here is an example for one signal path that is using a differential probe:

SwitchMatrixSetPathPrecisionProbe 'Strobe+' '4+' 'On=True;Mode=Probe;Cal
ibration=MyCalName'

NOTE With differential probes, you do not separately assign correction to the negative half of the 
signal.
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Microsoft .NET

When you need to access the full capabilities of the remote interface, use a .NET 
programming language. This enables your programs to make use of conditional 
statements, looping, event subscriptions, return value analysis, and more.

Example Code

The following C# code snippets demonstrate property actions and method 
invocations:

// Property actions
// ----------------

// Read the remote interface version
string version = remoteApp.RemoteInterfaceVersion;

// Prevent these dialogs from displaying during run
remoteApp.SuppressSimpleMessages = true;

// Method invocations
// ------------------

// Set one of the applications user-configurable options
remoteApp.SetConfig("speed", "fast");

// Save the current configuration
string fullPath = remoteApp.SaveProject("myProject");

// Custom property types
// ---------------------

// Query
ExistingResultsAction action = remoteApp.ExistingResultsAction;

// Set
remoteApp.ConnectionPromptAction = CustomPromptAction.AutoRespond;

// Custom types used in methods.
SaveProjectOptions options = new SaveProjectOptions();
options.Name = "MyProject";
options.BaseDirectory = "d:\MyProjects";
options.OverwriteExisting = true;
string fullPath = remoteApp.SaveProjectCustom(options);

ResultContainer results = remoteApp.GetResults();
MeasurementResult worstResult = results.WorstResults[0];
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Common Tasks

Here are common tasks you may want to perform in your programs. When there is 
more than one way to accomplish the task, alternatives are listed with a usage 
hint. For more information on each of the commands mentioned below, see the 
help file, "Keysight DigitalTestApps Remote Interface for .NET", located in the 
same directory as this programming guide.

• "Launching the automated test app" on page 47

• "Suppressing message prompts" on page 48

• "Configure settings found on the application's 'Set Up' and 'Configure' tabs" 
on page 48

• "Select tests to be run" on page 48

• "Run Tests" on page 48

• "Get Results" on page 48

• "Save the project" on page 49

• "Start a new project" on page 49

• "Open a project" on page 50

• "Exiting the automated test app" on page 50

Launching the automated test app

• Manually. Use any time.

Infiniium automated test apps: Use the oscilloscope menu: Analyze > Automated 
Test Apps > (AppName)

FlexDCA automated test apps: Use the oscilloscope menu: Apps > Automated 
Test Apps > (AppName)

Automated test apps: On your PC, launch the app using the Start menu or a 
shortcut.

• Using remote command. Send this SCPI command to Infiniium or FlexDCA:

:SYSTEM:LAUNCH 'AppName'

Where AppName is the name exactly as it appears in the menu system (see 
alternative above).

NOTE If a method demonstrated below does not enable you to customize the action as desired, 
check the command help file to see if there is a similarly named "XxxCustom" method that 
provides more flexibility.
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Suppressing message prompts

• Suppress "OK button" message prompts of type "Info", "Warning", or "Error". 
Use any time.

remoteAte.SuppressSimpleMessages = true;

• Suppress "OK/Cancel button" messages that ask you to enter a value. Use only 
if the application has defined a default value for that prompt; otherwise test will 
be aborted.

remoteAte.SuppressDataInputMessages = true;

• Suppress connection prompts. Use any time.

remoteAte.ConnectionPromptAction = CustomPromptAction.AutoRespond;

• Suppress "Signal Missing" prompts. Use any time.

remoteAte.SignalCheckFailAction = CustomPromptAction.AutoRespond;

• Suppress all of the above. See above for appropriate usage.

remoteAte.SuppressMessages = true;

Configure settings found on the application's 'Set Up' and 'Configure' tabs

remoteAte.SetConfig("variableName1", "value1");

Select tests to be run

• Select all of the tests currently shown on the application's 'Select Tests' tab. 
Use any time.

remoteAte.SelectAllTests();

• Select a subset of the available tests. Use any time.

remoteAte.SelectedTests = new int[]{123,456,etc.};

Run Tests

• With defaults. Use any time.

remoteAte.Run();

• With options. Use when you want to override the user preferences currently 
active in the target application.

RunOptions options = new RunOptions();
options.StopRunIfTestAborts = true;
remoteAte.RunCustom(options);

Get Results

• Quick overall result. Use any time.

bool passed = remoteAte.Passed;
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• Get full details for all existing test results. Use any time.

ResultContainer results = remoteAte.GetResults();

• Get a subset of all available results. Use any time.

ResultOptions options = new ResultOptions();
options.TestIds = new int[]{123,456};
remoteAte.GetResultsCustom(options);

• CSV report. Use when you want CSV results in a separate file. File "results.csv" 
will be located inside the project.

remoteAte.ExportResultsCsv();
remoteAte.SaveProject("Project1");

• CSV text. Use when you want to see the CSV results on the remote client.

ResultOptions options = new ResultOptions();
options.TestIds = new int[]{123,456};
options.IncludeCsvData = true;
remoteAte.GetResultsCustom(options);

• HTML Report.

The .html file is located in the saved project.

Save the project

• Using default location property. Use when that location does not already have a 
project by the same name (although re-saves to the same location are allowed). 
Otherwise, save will be aborted.

remoteAte.SaveProject("Project1");

• Using options. Use any time.

SaveProjectOptions options = new SaveProjectOptions();
options.Name = "Project1";
options.BaseDirectory = @"c:\...\MyProjectDir";
options.OverwriteExisting = true;
remoteAte.SaveProjectCustom (options);

Start a new project

• Checking method. Use when you want to be warned when unsaved results 
exist.

remoteAte.NewProject(false);

• Forced method. Use when you always want this command to complete 
(unsaved results will be discarded).

remoteAte.NewProject(true);
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Open a project

• Using default location. Use when you want to be warned when unsaved results 
exist.

remoteAte.OpenProject("Project1");

• Using options. Use any time.

OpenProjectOptions options = new OpenProjectOptions();
options.FullPath = "c:\\...\\MyProjectDir\\Project1";
options.DiscardUnsaved = true;
remoteAte.OpenProjectCustom(options);

Exiting the automated test app

• Safer method. Use when you do not want to risk losing unsaved results (action 
will fail if unsaved results exist).

remoteAte.Exit(false, true);

• Forced method. Use when you always want this command to complete 
(unsaved results will be discarded).

remoteAte.Exit(true, true);

Example Programs

The following example:

1 Loads an existing project.

2 Executes multiple tests one at a time, giving you an opportunity to modify the 
device under test in between tests.

3 At the end of the run, saves the resulting project.

4 Exports the tests results to a .csv file for post processing.

using System;
using System.IO;
using Keysight.DigitalTestApps.Framework.Remote;

...
IRemoteAte remoteAte =

RemoteAteUtilities.GetRemoteAte("123.45.67.890");
remoteAte.SuppressMessages = true;

// TODO: Read/write share directory "c:\Automated Test Apps" on the
// PC that will be running this automation program (directory name
// is arbitrary).
const string baseDirectory = "Automated Test Apps";

// Tell the app to load the starting project from the PC this
// automation program is running on.
OpenProjectOptions openProjectOptions = new OpenProjectOptions();
openProjectOptions.DiscardUnsaved = true;
openProjectOptions.FullPath = "\\\\MyPCName\\" + baseDirectory +
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"\\DDR3\\Base Project\\Base Project.proj";
remoteAte.OpenProjectCustom(openProjectOptions);

// Run the first test
remoteAte.SelectedTests = new int[] {123};
remoteAte.Run();

// Modify DUT/switch, etc. here

// Run the second test
// This unselects test 123.
remoteAte.SelectedTests = new int[] {456};
// This appends 456 results to the existing results for test 123.
remoteAte.Run();

// Tell the app to save the entire project to the PC this automation
// program is running on.
SaveProjectOptions saveProjectOptions = new SaveProjectOptions();
saveProjectOptions.BaseDirectory = "\\\\MyPCName\\" + baseDirectory +

"\\DDR3";
saveProjectOptions.Name = "My DDR3 Device";
saveProjectOptions.OverwriteExisting = true;
remoteAte.SaveProjectCustom(saveProjectOptions);

// Export CSV results.
ResultOptions resultOptions = new ResultOptions();
resultOptions.IncludeCsvData = true;
ResultContainer resultContainer =

remoteAte.GetResultsCustom(resultOptions);
StreamWriter writer = null;

try
{

// Because this file is being created by this automation program
// which is running on the PC, use the local, not network, path.
// For convenience sake, this example saves it to the directory
// which contains the entire project; file name is arbitrary.
writer = new StreamWriter("c:\\" + baseDirectory + "\\DDR3\\" +

saveProjectOptions.Name + "\\AllResults.csv");
writer.WriteLine(resultContainer.CsvResults);

}
finally
{
if (writer != null) writer.Close();

}
...

See Chapter 1, "Remote Interface Documentation" on page 10, for more 
information on getting your application's test IDs.

NOTE Replace "123.45.67.890" with the actual IP address of the oscilloscope running your 
automated test application, and replace "123" with an actual test ID for the application.
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Advanced Topic: Event Handling

The above examples demonstrate how to use the "forward facing" (remote client 
-> automated test application) direction of the remote interface. The remote 
interface also has a "callback" (automated test application -> remote client) 
direction, described in "Keysight.DigitalTestApps.Framework.Remote.Advanced" 
on page 12. A sample implementation using this capability can be found in: 
"Message Handling Remote Client Implementation" on page 92.

Advanced Topic: Switch Matrix

The following C# code snippets demonstrate how to configure the Switch Matrix 
controller.

Using Automatic Mode

remoteAte.SwitchMatrixOn = true;
remoteAte.SwitchMatrixSelectModeAuto("Keysight U3020A S26");
remoteAte.SwitchMatrixConnectToInstrument(1, "lan[123.456.7890]:inst0");

If additional drivers were created by the app during execution of 
SwitchMatrixSelectModeAuto, simply execute 
SwitchMatrixConnectToInstrument again for each driver ID and instrument 
address. Each driver must be connected to a separate switch matrix instrument.

Using Manual Mode

remoteAte.SwitchMatrixOn = true;
remoteAte.SwitchMatrixSelectModeManual();
remoteAte.SwitchMatrixAddDriver("Keysight U3020A S26");
remoteAte.SwitchMatrixConnectToInstrument(1,"lan[123.456.7890]:inst0");

To create an additional driver, simply add these lines:

remoteAte.SwitchMatrixAddDriver("Keysight U3020A S26");
remoteAte.SwitchMatrixConnectToInstrument(2,"lan[123.456.7890]:inst0");

Each driver must be connected to a separate switch matrix instrument.

Now you need to manually define each signal path, each one starting from the test 
point on the Device Under Test, through the switch, and ending with the scope 
channel.

NOTE Replace 123.456.7890 with the full SICL address or VISA alias of your switch instrument.

NOTE Replace 123.456.7890 with the full SICL address or VISA alias of your switch instrument.
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Here is an example of a single-ended signal going into scope channel 3:

SwitchInfo info = new SwitchInfo();
info.Driver = 1;
info.Slot = 1;
info.Input = 1;
remoteAte.SwitchMatrixDefineSignalPath("CLK",info,"3");

Here is an example of a differential signal going into a differential probe connected 
to scope channel 4:

SwitchInfo info = new SwitchInfo();
info.Driver = 1;
info.Slot = 1;
info.Input = 1;
remoteAte.SwitchMatrixDefineSignalPath("Strobe+",info,"4+");
info = new SwitchInfo();
info.Driver = 1;
info.Slot = 2;
info.Input = 1;
remoteAte.SwitchMatrixDefineSignalPath("Strobe-",info,"4-");

Using Either Mode

All that remains is to assign a correction method to each signal path. This is 
optional but highly recommended.

Here is an example for one signal path that is using a single-ended probe:

PrecisionProbeOptions options = new PrecisionProbeOptions();
options.On = true;
options.Mode = PrecisionProbeOptions.PrecisionProbeMode.Probe;
options.Calibration = "MyCalName";
remoteAte.SwitchMatrixSetPathPrecisionProbe("CLK", "3", options);

Here is an example for one signal path that is using a differential probe:

PrecisionProbeOptions options = new PrecisionProbeOptions();
options.On = true;
options.Mode = PrecisionProbeOptions.PrecisionProbeMode.Probe;
options.Calibration = "MyCalName";
remoteAte.SwitchMatrixSetPathPrecisionProbe("Strobe+","4+",options);

Advanced Topic: Parallel Testing

To accelerate testing of multiple devices, you may control multiple automated test 
applications (running on different scopes) in parallel using the multi-threading 
capabilities available in .NET. For example:

public void DoMultiScopeTesting()
{

NOTE With differential probes, you do not separately assign correction to the negative half of the 
signal.
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Thread t1 = _StartTestingOnScope("<IP address 1>");
Thread t2 = _StartTestingOnScope("<IP address 2>");
t1.Join();
t2.Join();

}

private Thread _StartTestingOnScope(string ipAddress)
{

var t = new Thread(() => _Execute(ipAddress));
t.Start();
return t;

}

private static void _Execute(string ipAddress)
{

IRemoteAte remoteAte = RemoteAteUtilities.GetRemoteAte(ipAddress);
...

}

This program will let both automated test applications run without waiting for each 
other. The calls to _StartTestingOnScope are not blocking, so the program starts 
both apps running and then proceeds to the first Join statement, where it waits for 
the first app to complete. Then, the program moves on to the second Join where it 
waits for the second app to complete (it's okay if it finished first).

NOTE This solution requires .NET 3.5 or newer on the remote client. Multi-threading is also possible 
with older .NET versions using less robust techniques.
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Python

You can combine the ease of text-based programming with the depth of the .NET 
API by choosing an interpreted language with .NET compatibility, such as 
CPython. By installing the Python for .NET package, you gain access to the power 
of multi-paradigm programming: You can choose to write traditional "function 
call" code utilizing the .NET API or you can choose to write SCPI-like "text-based" 
code which takes advantage of the ARSL syntax. Both of these are demonstrated 
below.

Furthermore, using the Python Visa package, you can even launch the automated 
test app from the same script that controls it.

Using the Python Visa Package

The Python VISA package, or PyVISA, is free open source software available from: 
"http://pyvisa.sourceforge.net/". When you install this package you will be able to 
connect to an Keysight oscilloscope or FlexDCA and launch an automated test 
application using code as simple as:

import visa
infiniium = visa.instrument("<VISA>")

# Where <VISA> is the VISA address of the oscilloscope, for example,
# visa.instrument("TCPIP0::123.45.67.890::inst0:INSTR")

infiniium.write(":SYSTEM:LAUNCH '<application name>'")
# Where <application name> is the exact text that appears in the
# scope or FlexDCA applications menu, for example,
# infiniium.write(":SYSTEM:LAUNCH 'N5393C PCIExpress Test App'")

Using the Python for .NET Package

The Python for .NET package is free open source software available from: 
"http://pythonnet.sourceforge.net/". When you install a CLR 2.0 package you will 
be able to connect to and control a launched Keysight automated test application 
using code as simple as:

import clr
clr AddReference("Keysight.DigitalTestApps.Framework.Remote")
from Keysight.DigitalTestApps.Framework.Remote import *
remoteObj = RemoteAteUtilities.GetRemoteAte("<ip>")

# Where <ip> is the oscilloscope's IP address, for example,
# RemoteAteUtilities.GetRemoteAte("123.45.67.890")

remoteApp = IRemoteAte(remoteObj)
remoteApp.<method or property>

# Where <method or property> is any method or property found in
# the application's .NET interface, described in Chapter 1.
# For example,
# remoteApp.Run()

To make this work, you need to copy a few files to your Python installation 
directory, for example, c:\Python27\DLLs\:

http://pyvisa.sourceforge.net/
http://pythonnet.sourceforge.net/
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• From the Python for .NET package:

clr.pyd

Python.Runtime.dll

• From the Keysight N5452A Remote Toolkit:

Keysight.DigitalTestApps.Framework.Remote.dll

Keysight.DigitalTestApps.Framework.Remote.config

Example Code

The following Python code snippets demonstrate property actions and method 
invocations:

# Property actions
# ----------------
# Read the remote interface version
version = remoteApp.RemoteInterfaceVersion
# Prevent these dialogs from displaying during run
remoteApp.SuppressSimpleMessages = True

# Method invocations
# ------------------
# Set one of the applications user-configurable options
remoteApp.SetConfig("speed", "fast")
# Save the current configuration
fullPath = remoteApp.SaveProject("myProject")

# Custom property types
# ---------------------
# Query
action = remoteApp.ExistingResultsAction
# Set
remoteApp.ConnectionPromptAction = CustomPromptAction.AutoRespond
# Custom types used in methods.
options = SaveProjectOptions()
options.Name = "MyProject"
options.BaseDirectory = "d:\\MyProjects"
options.OverwriteExisting = True
fullPath = remoteApp.SaveProjectCustom(options)
results = remoteApp.GetResults()
extremeResult = results.ExtremeResults[0];

The following Python code snippets demonstrate the equivalent actions using 
SCPI-like ARSL-formatted strings:

# Property actions
# ----------------
# Read the remote interface version

NOTE Be sure to keep these files together in the same directory.
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version = remoteApp.ExecuteArsl("RemoteInterfaceVersion?")
remoteApp.ExecuteArsl("SuppressSimpleMessages True")

# Method invocations
# ------------------
# Set one of the applications user-configurable options
remoteApp.ExecuteArsl("SetConfig 'speed' 'fast'")
# Save the current configuration
fullPath = remoteApp.ExecuteArsl("SaveProject 'myProject'")

# Custom property types
# ---------------------
# Query
action = remoteApp.ExecuteArsl("ExistingResultsAction?")
# Set
remoteApp.ExecuteArsl("ConnectionPromptAction AutoRespond")
# Custom types used in methods.
fullPath = remoteApp.ExecuteArsl("SaveProjectCustom " + \

"'Name=MyProject;BaseDirectory=" + \
"d:\\MyProjects;OverwriteExisting=True'")

results = remoteApp.ExecuteArsl("GetResults")

Common Tasks

Here are common tasks you may want to perform in your programs. When there is 
more than one way to accomplish the task, alternatives are listed with a usage 
hint. Both method call and ARSL-formatted text paradigms are presented. For 
more information on each of the commands mentioned below, see the help file, 
"Keysight DigitalTestApps Remote Interface for .NET", located in the same 
directory as this programming guide.

• "Launching the automated test app" on page 58

• "Suppressing message prompts" on page 58

• "Configure settings found on the application's 'Set Up' and 'Configure' tabs" 
on page 59

• "Select tests to be run" on page 59

• "Run Tests" on page 59

• "Get Results" on page 60

• "Save the project" on page 61

• "Start a new project" on page 61

• "Open a project" on page 62

• "Exiting the automated test app" on page 62

NOTE If a method demonstrated below does not enable you to customize the action as desired, 
check the command help file to see if there is a similarly named "XxxCustom" method that 
provides more flexibility.
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Launching the automated test app

• Manually. Use any time.

Infiniium automated test apps: Use the oscilloscope menu: Analyze > Automated 
Test Apps > (AppName)

FlexDCA automated test apps: Use the oscilloscope menu: Apps > Automated 
Test Apps > (AppName)

Automated test apps: On your PC, launch the app using the Start menu or a 
shortcut.

• Using remote command. Send this SCPI command to Infiniium or FlexDCA:

:SYSTEM:LAUNCH 'AppName'

Where AppName is the name exactly as it appears in the menu system (see 
alternative above).

Suppressing message prompts

• Suppress "OK button" message prompts of type "Info", "Warning", or "Error". 
Use any time.

Method call:

remoteApp.SuppressSimpleMessages = True

Text:

remoteApp.ExecuteArsl("SuppressSimpleMessages True")

• Suppress "OK/Cancel button" messages that ask you to enter a value. Use only 
if the application has defined a default value for that prompt; otherwise test will 
be aborted.

Method call:

remoteApp.SuppressDataInputMessages = True

Text:

remoteApp.ExecuteArsl("SuppressDataInputMessages True")

• Suppress connection prompts. Use any time.

Method call:

remoteApp.ConnectionPromptAction = CustomPromptAction.AutoRespond

Text:

remoteApp.ExecuteArsl("ConnectionPromptAction AutoRespond")

• Suppress "Signal Missing" prompts. Use any time.

Method call:
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remoteApp.SignalCheckFailAction = CustomPromptAction.AutoRespond

Text:

remoteApp.ExecuteArsl("SignalCheckFailAction AutoRespond")

• Suppress all of the above. See above for appropriate usage.

Method call:

remoteApp.SuppressMessages = True

Text:

remoteApp.ExecuteArsl("SuppressMessages True")

Configure settings found on the application's 'Set Up' and 'Configure' tabs

Method call:

remoteApp.SetConfig("variableName1", "value1")

Text:

remoteApp.ExecuteArsl("SetConfig 'variableName1' 'value1'")

Select tests to be run

• Select all of the tests currently shown on the application's 'Select Tests' tab. 
Use any time.

Method call:

remoteApp.SelectAllTests()

Text:

remoteApp.ExecuteArsl("SelectAllTests")

• Select a subset of the available tests. Use any time.

Method call:

remoteApp.SelectedTests = [123,456,etc.]

Text:

remoteApp.ExecuteArsl("SelectedTests 123,456,etc.")

Run Tests

• With defaults. Use any time.

Method call:

remoteApp.Run()

Text:

remoteApp.ExecuteArsl("Run")
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• With options. Use when you want to override the user preferences currently 
active in the target application.

Method call:

runOptions = RunOptions()
runOptions.StopRunIfTestAborts = True
remoteApp.RunCustom(runOptions)

Text:

remoteApp.ExecuteArsl("RunCustom 'StopRunIfTestAborts=True'")

Get Results

• Quick overall result. Use any time.

Method call:

passed = remoteAte.Passed

Text:

remoteApp.ExecuteArsl("Passed?")

• Get full details for all existing test results. Use any time.

Method call:

results = remoteAte.GetResults()

Text:

remoteApp.ExecuteArsl("GetResults")

• Get a subset of all available results. Use any time.

Method call:

resultOptions = ResultOptions()
resultOptions.TestIds = [123,456]
remoteApp.GetResultsCustom(resultOptions)

Text:

remoteApp.ExecuteArsl("GetResultsCustom 'TestIds=123,456'")

• CSV report. Use when you want CSV results in a separate file. File "results.csv" 
will be located inside the project.

Method call:

remoteApp.ExportResultsCsv()
remoteApp.SaveProject("Project1")

Text:

remoteApp.ExecuteArsl("ExportResultsCsv")
remoteApp.ExecuteArsl("SaveProject 'Project1'")

• CSV text. Use when you want to see the CSV results on the remote client.
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Method call:

resultOptions = ResultOptions()
resultOptions.TestIds = [123,456]
resultOptions.IncludeCsvData = True
remoteApp.GetResultsCustom(resultOptions)

Text:

remoteApp.ExecuteArsl("GetResultsCustom 'TestIds=123,456;IncludeCsvDa
ta=True'")

• HTML Report.

The .html file is located in the saved project.

Save the project

• Using default location property. Use when that location does not already have a 
project by the same name (although re-saves to the same location are allowed). 
Otherwise, save will be aborted.

Method call:

remoteApp.SaveProject("Project1")

Text:

remoteApp.ExecuteArsl("SaveProject 'Project1'")

• Using options. Use any time.

Method call:

saveProjectOptions = SaveProjectOptions()
saveProjectOptions.Name = "Project1"
saveProjectOptions.BaseDirectory = "c:\\...\\MyProjectDir"
saveProjectOptions.OverwriteExisting = True
remoteApp.SaveProjectCustom(saveProjectOptions)

Text:

remoteApp.ExecuteArsl("SaveProjectCustom 'Name=Project1;BaseDirectory
=c:\\...\\MyProjectDir;OverwriteExisting=True'")

Start a new project

• Checking method. Use when you want to be warned when unsaved results 
exist.

Method call:

remoteApp.NewProject(False)

Text:

remoteApp.ExecuteArsl("NewProject False")
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• Forced method. Use when you always want this command to complete 
(unsaved results will be discarded).

Method call:

remoteApp.NewProject(True)

Text:

remoteApp.ExecuteArsl("NewProject True")

Open a project

• Using default location. Use when you want to be warned when unsaved results 
exist.

Method call:

remoteApp.OpenProject("Project1")

Text:

remoteApp.ExecuteArsl("OpenProject 'Project1'")

• Using options. Use any time.

Method call:

openProjectOptions = OpenProjectOptions()
openProjectOptions.FullPath = "c:\\...\\MyProjectDir\\Project1"
openProjectOptions.DiscardUnsaved = True
remoteApp.OpenProjectCustom(openProjectOptions)

Text:

remoteApp.ExecuteArsl("OpenProjectCustom 'FullPath=c:\\...\\
MyProjectDir\\Project1;DiscardUnsaved=True'")

Exiting the automated test app

• Safer method. Use when you do not want to risk losing unsaved results (action 
will fail if unsaved results exist).

Method call:

remoteApp.Exit(False, True)

Text:

remoteApp.ExecuteArsl("Exit False True")

• Forced method. Use when you always want this command to complete 
(unsaved results will be discarded).

Method call:

remoteApp.Exit(True, True)

Text:
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remoteApp.ExecuteArsl("Exit True True")

Example Programs

The following example:

1 Launches the DDR3 automated test application.

2 Loads an existing project.

3 Executes multiple tests one at a time, giving you an opportunity to modify the 
device under test in between tests.

4 At the end of the run, saves the resulting project.

5 Exports the tests results to a .csv file for post processing.

The example is presented in both method call and text paradigms.

Using Method
Calls

"""Import the compiled Python Visa module"""
import visa

"""Connect to the scope"""
remoteScope = visa.instrument("enter scope's VISA address here")

"""Launch the DDR3 application"""
remoteScope.write(":SYSTEM:LAUNCH 'DDR3 Test'")

"""Import the compiled Python for .Net module"""
import clr

"""Import the Keysight automated test app remote library DLL"""
clr.AddReference("Keysight.DigitalTestApps.Framework.Remote")
from Keysight.DigitalTestApps.Framework.Remote import *

"""Connect to the automated test application running on the scope
This will wait for the application to be fully launched and ready
before proceeding"""
scopeIpAddress = "123.45.67.890"
remoteObj = RemoteAteUtilities.GetRemoteAte(scopeIpAddress)
remoteApp = IRemoteAte(remoteObj)

"""Prevent dialogs from displaying during the run"""
remoteApp.SuppressMessages = True

"""Ensure app settings are in a known state"""
remoteApp.NewProject(True)

"""Select the tests to be run
Use commas to separate multiple IDs"""
remoteApp.SelectedTests = [50000]

"""Set a variable found on the app's 'Configure' tab
Get variable name and valid options from app's remote help file
or from GUI hints"""
remoteApp.SetConfig("TrigChan","CHAN4")
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"""Start the run. This is a blocking call...
program will wait until app is finished."""
remoteApp.Run()

"""Save the project"""
saveOptions = SaveProjectOptions()
saveOptions.BaseDirectory = "c:\\temp"
saveOptions.Name = "Demo"
saveOptions.OverwriteExisting = True
projectFullPath = remoteApp.SaveProjectCustom(saveOptions)
print projectFullPath

"""This will print the extreme results to the console window
in which this script is running."""
results = remoteApp.GetResults()

"""This will get all results in csv format"""
resultOptions = ResultOptions()
resultOptions.TestIds = [123]
resultOptions.IncludeCsvData = True
customResults = remoteApp.GetResultsCustom(resultOptions)
print customResults.CsvResults

Using
ARSL-Formatted

Text

"""Import the compiled Python Visa module"""
import visa

"""Connect to the scope"""
remoteScope = visa.instrument("enter scope's VISA address here")

"""Launch the DDR3 application"""
remoteScope.write(":SYSTEM:LAUNCH 'DDR3 Test'")

"""Import the compiled Python for .Net module"""
import clr

"""Import the Keysight automated test app remote library DLL"""
clr.AddReference("Keysight.DigitalTestApps.Framework.Remote")
from Keysight.DigitalTestApps.Framework.Remote import *

"""Connect to the automated test application running on the scope
This will wait for the application to be fully launched and ready
before proceeding"""
scopeIpAddress = "123.45.67.890"
remoteObj = RemoteAteUtilities.GetRemoteAte(scopeIpAddress)
remoteApp = IRemoteAte(remoteObj)

"""Prevent dialogs from displaying during the run"""
remoteApp.ExecuteArsl("SuppressMessages True")

"""Ensure app settings are in a known state"""
remoteApp.ExecuteArsl("NewProject True")

"""Select the tests to be run
Use commas to separate multiple IDs"""
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remoteApp.ExecuteArsl("SelectedTests 123")

"""Set a variable found on the app's 'Configure' tab
Get variable name and valid options from app's remote help file
or from GUI hints"""
remoteApp.ExecuteArsl("SetConfig 'TrigChan' 'CHAN4'")

"""Start the run. This is a blocking call...
program will wait until app is finished."""
remoteApp.ExecuteArsl("Run")

"""Save the project"""
print remoteApp.ExecuteArsl("SaveProjectCustom 'BaseDirectory=" + \

"c:\\temp;Name=Demo;OverwriteExisting=True'")

"""This will print the extreme results to the console window in which
this script is running."""
print remoteApp.ExecuteArsl("GetResults")

"""This will get all results in csv format"""
print remoteApp.ExecuteArsl("GetResultsCustom " + \

"'TestIds=50000;IncludeCsvData=True'")

See Chapter 1, "Remote Interface Documentation" on page 10, for more 
information on getting your application's test IDs.

Advanced Topic: Event Handling

The above examples demonstrate how to use the "forward facing" (remote client 
-> automated test application) direction of the remote interface. The remote 
interface also has a "callback" (automated test application -> remote client) 
direction, described here 
"Keysight.DigitalTestApps.Framework.Remote.Advanced" on page 12. A sample 
implementation using this capability follows.

The Python script shown below accomplishes the following tasks:

• Connects to an automated test application.

• Establishes the callback pipe.

• Redirects messages (prompts) to the remote client machine.

• Programmatically responds to a message (without displaying it).

"""Import the compiled Python for .Net module"""
import clr

"""Import .NET types"""
from System.Runtime.Remoting import *
from System.Windows.Forms import *

NOTE Replace "123.45.67.890" with the actual IP address of the oscilloscope running your 
automated test application, and replace "123" with an actual test ID for the application.
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"""Import the Keysight automated test app remote library DLL"""
clr.AddReference("Keysight.DigitalTestApps.Framework.Remote")
from Keysight.DigitalTestApps.Framework.Remote import *

"""Define the event callback handler"""
def SimpleMessageEventHandler(source, args):

print 'Received message: ' + args.Message

if args.Message.find("All selected tests completed") >= 0:
args.Response = DialogResult.OK

else:
print 'Message not handled'

"""Connect to the automated test application running on the scope
This will wait for the application to be fully launched and ready
before proceeding"""
scopeIpAddress = "123.45.67.890"
remoteObj = RemoteAteUtilities.GetRemoteAte(scopeIpAddress)
remoteApp = IRemoteAte(remoteObj)

"""Verify Connection"""
print remoteApp.ApplicationName

"""Establish callback path"""
configFileFullPath = "c:\Python27\DLLs\
Keysight.Infiniium.AppFw.Remote.config";
RemotingConfiguration.Configure(configFileFullPath, False);
eventSink = RemoteAteUtilities.CreateAteEventSink(remoteApp, None, scope
IpAddress)

"""Subscribe to message events"""
eventSink.RedirectMessagesToClient = True
eventSink.SimpleMessageEvent += SimpleMessageEventHandler

"""Run tests"""
try:

remoteApp.SelectedTests = [123]
remoteApp.Run()

except Exception, e:
print e.Message

"""Unsubscribe from message events and clean up"""
eventSink.SimpleMessageEvent -= SimpleMessageEventHandler
eventSink.Dispose()

NOTE Replace "c:\Python27\DLLs\" with the actual location of the configuration file, replace 
"123.45.67.890" with the actual IP address of the oscilloscope running your automated test 
application, and replace "123" with an actual test ID for the application.
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Tips:

1 Use of the remote interface's callback path requires a .NET Remoting 
configuration file, Keysight.DigitalTestApps.Framework.Remote.config, which 
contains settings for the callback pipe. This file may be found in the remote 
toolkit in the Tools subdirectory.

2 The example script only handles the prompt that appears at the end of a run, 
because of this line:

if args.Message.find("All selected tests completed") >= 0:

To handle other prompts, add another case to the function, for example:

if args.Message.find("All selected tests completed") >= 0:
args.Response = DialogResult.OK

elif args.Message.find("Some other message") >= 0:
args.Response = DialogResult.Yes

else:
print 'Message not handled'

Note that code located inside an automated test app event handler, such as the 
SimpleMessageEventHandler, is executing in a "dummy" thread, which are threads 
of control started outside the Python threading module that have limited 
functionality. Certain actions cannot succeed inside a dummy thread, such as 
making a DDE (Dynamic Data Exchange) call. To handle this limitation, you need 
to use a mechanism that can reassign such actions to Python's main thread.

The remote toolkit contains a class named CrossThreadFunctionInvoker that 
enables you to do this, along with two programs that demonstrate usage of the 
class. These are contained in the Source\Python subdirectory:

CAUTION Compliance apps generate messages having Unicode encoding. Therefore, if you print 
messages received from the automated test application you may encounter a 
UnicodeEncodeError exception if the messages contain certain characters, for 
example, single quote characters U+2018 and U+2019. Please see your Python 
documentation for instructions on how to handle Unicode text.

NOTE Replace "Yes" with the actual name of a button that appears on the prompt.

File Description

CrossThreadFunctionInvoker.py Contains the CrossThreadFunctionInvoker class and a 
simple program to demonstrate its usage

CrossThreadFunctionInvokerAppExample
.py

Contains a sample automated test app automation 
program that uses the CrossThreadFunctionInvoker 
class
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Advanced Topic: Switch Matrix

The following Python code snippets demonstrate how to configure the Switch 
Matrix controller.

Using Automatic Mode

remoteApp.SwitchMatrixOn = True
remoteApp.SwitchMatrixSelectModeAuto("Keysight U3020A S26")
remoteApp.SwitchMatrixConnectToInstrument(1, "lan[123.456.7890]:inst0")

If additional drivers were created by the app during execution of 
SwitchMatrixSelectModeAuto, simply execute 
SwitchMatrixConnectToInstrument again for each driver ID and instrument 
address. Each driver must be connected to a separate switch matrix instrument.

Using Manual Mode

remoteApp.SwitchMatrixOn = True
remoteApp.SwitchMatrixSelectModeManual()
remoteApp.SwitchMatrixAddDriver("Keysight U3020A S26")
remoteApp.SwitchMatrixConnectToInstrument(1,"lan[123.456.7890]:inst0")

To create an additional driver, simply add these lines:

remoteApp.SwitchMatrixAddDriver("Keysight U3020A S26");
remoteApp.SwitchMatrixConnectToInstrument(2,"lan[123.456.7890]:inst0")

Each driver must be connected to a separate switch matrix instrument.

Now you need to manually define each signal path, each one starting from the test 
point on the Device Under Test, through the switch, and ending with the scope 
channel.

Here is an example of a single-ended signal going into scope channel 3:

info = SwitchInfo()
info.Driver = 1
info.Slot = 1
info.Input = 1
remoteApp.SwitchMatrixDefineSignalPath("CLK",info,"3")

Here is an example of a differential signal going into a differential probe connected 
to scope channel 4:

NOTE Replace 123.456.7890 with the full SICL address or VISA alias of your switch instrument

NOTE Replace 123.456.7890 with the full SICL address or VISA alias of your switch instrument.
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info = SwitchInfo()
info.Driver = 1
info.Slot = 1
info.Input = 1
remoteApp.SwitchMatrixDefineSignalPath("Strobe+",info,"4+")
info = SwitchInfo()
info.Driver = 1
info.Slot = 2
info.Input = 1
remoteApp.SwitchMatrixDefineSignalPath("Strobe-",info,"4-")

Using Either Mode

All that remains is to assign a correction method to each signal path. This is 
optional but highly recommended.

Here is an example for one signal path that is using a single-ended probe:

options = PrecisionProbeOptions()
options.On = True
options.Mode = PrecisionProbeOptions.PrecisionProbeMode.Probe
options.Calibration = "MyCalName"
remoteApp.SwitchMatrixSetPathPrecisionProbe("CLK", "3", options)

Here is an example for one signal path that is using a differential probe:

options = PrecisionProbeOptions()
options.On = True
options.Mode = PrecisionProbeOptions.PrecisionProbeMode.Probe
options.Calibration = "MyCalName"
remoteApp.SwitchMatrixSetPathPrecisionProbe("Strobe+","4+",options)

NOTE With differential probes, you do not separately assign correction to the negative half of the 
signal.
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Determine required tasks by first using the graphical user interface

Before you write remote programming code to perform a task, it is often best to 
begin by determining the steps required to execute the task via the user interface 
on the oscilloscope. This will often help you avoid problems caused by incorrect 
step sequencing.

For example, automated test applications often manage large list of tests by 
providing a test filter. This is usually presented as a radio button group on the "Set 
Up" tab that determines which tests are visible on the "Select Tests" tab. Suppose 
these were your options:

"Set Up" tab:

• Speed: o Low o High

Imagine that when "Low" is selected, a configuration variable named "Speed" is 
set to value "Low" and the "Select Tests" tab is populated with three low-speed 
tests:

"Select Tests" tab:

• All Tests

• Low Speed Test #1

• Low Speed Test #2

• Low Speed Test #3

Similarly, when "High" is selected on the "Set Up" tab, variable "Speed" is set to 
"High" and a different set of tests are shown:

"Select Tests" tab:

• All Tests

• High Speed Test #1

• High Speed Test #2

• High Speed Test #3

Using the application's user interface, it is impossible to cause an invalid situation 
because only the currently available tests are displayed for you to select. However, 
via the remote interface you can request any test by setting the SelectedTests 
property. If you ask for an unavailable test, such as asking for High Speed Test #1 
when "Speed" = "Low", the automated test application will throw an exception 
across the remote interface that your client will need to handle.

By first exploring the task via the user interface, though, you can avoid this 
exception by realizing you must first call SetConfig("Speed", "High") before calling 
RunTests() for a high-speed test.
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Verify the remote commands one at a time

After you've converted some of the manual steps into remote interface commands 
(see "Determine required tasks by first using the graphical user interface" on 
page 72), execute them one at a time, either in the debugger or by sending them 
using the ARSL Command Line Utility. In many cases, you will be able to verify 
their success by visually inspecting the application on the oscilloscope.
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Check the log

The automated test application logs all incoming remote commands to a file. You 
can visually inspect this file to see how your remote commands executed in 
relation to other events that get logged.

The log file is named message_#.log and may be found in one of these locations:

• For automated test apps that run directly on an oscilloscope:

• Remote Interface Versions 1.10 and earlier: C:\scope\apps\(application 
name)\Scratchpad\

• Remote Interface Version 1.20 and later: C:\Documents and Settings\All 
Users\Application Data\Keysight\Infiniium\Apps\(application name)\
Project\

• Remote Interface Version 1.40 and later:

• WinXP: C:\Documents and Settings\All Users\Application Data\Agilent\
Infiniium _or_ FlexDCA\Apps\(application name)\Log\

• Win7: C:\ProgramData\Agilent _or_ Keysight\Infiniium _or_ FlexDCA\
Apps\(application name)\Log\

• For automated test apps that run on a separate PC:

• WinXP: C:\Documents and Settings\All Users\Application Data\Agilent\
Infiniium _or_ FlexDCA\Apps\(application name)\Project\

- Or -

C:\Documents and Settings\All Users\Application Data\Agilent\Scope\
Apps\(application name)\Log

• Win7: C:\ProgramData\Agilent _or_ Keysight\Infiniium _or_ FlexDCA\Apps\
(application name)\Project\

A standard .NET command gets logged this way:

1/8/2008 11:20:39 AM RPIC 55 RemoteInterfaceVersion?
1/8/2008 11:20:39 AM RPIR 55 <1.0>

The fields contain the following information:

1/8/2008 11:20:39 AM RPIC 55 RemoteInterfaceVersion?
-------------------- ---- -- -----------------------

1 2 3 4

1 Timestamp.

2 Remote command log code.

3 Remote command sequence number.

4 Remote command.

A unique sequence number identifies command/response pairs. The remote 
command log code types are:



Recommended Remote Programming Practices 4

Keysight DigitalTestApps Programming Guide 75

 

Here's another example. An ARSL command looks like this:

1/8/2008 11:22:36 AM RPIC 72 ExecuteArsl RemoteInterfaceVersion?
1/8/2008 11:22:36 AM RPIC 73 RemoteInterfaceVersion?
1/8/2008 11:22:36 AM RPIR 73 <1.0>
1/8/2008 11:22:36 AM RPIR 72 <>

Here you see that the ARSL command is translated into its .NET equivalent and 
then executed.

If the remote command results in user messages being generated, these will 
appear in the log as well. For example:

1/8/2008 11:25:22 AM RPIC 74 SelectedTests 50000
1/8/2008 11:25:22 AM RPIR 74 <>
1/8/2008 11:25:24 AM RPIC 75 Run
1/8/2008 11:25:35 AM TLCL Information All Tests Complete
Total Test Time: 0.1093743 sec
Multi-Trials Count Up Test: 0.1093743s
1/8/2008 11:25:35 AM RPIR 75 <>

In this example, a test named "Multi-Trials Count Up Test" is selected and run. The 
"all tests complete" message is logged as well. Here are the field descriptions for 
user message log entries:

1/8/2008 11:25:35 AM TLCL Information All Tests Complete
-------------------- ---- ------------------------------

1 2 3

1 Timestamp.

2 User Message log code.

3 User Message.

Messages are grouped into three categories:

Here is the complete list of user message log codes you may encounter during 
remote operation:

RPIC Remote Programming Interface Command.

RPIR Remote Programming Interface Response.

Tell Errors, warnings, and info messages that have only an OK button.

Ask Messages include other response types such as "Retry/Cancel" or "Yes/No".

AskForData Messages that require the user to enter a value.

ALCL Ask message displayed locally (on oscilloscope).

ARMT Ask message redirected to remote client.
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ASPR Ask message suppressed by remote client.

DLCL AskForData message displayed locally (on oscilloscope).

DRMT AskForData message redirected to remote client.

DSPR AskForData message suppressed by remote client.

TLCL Tell message displayed locally (on oscilloscope).

TRMT Tell messages redirected to remote client.

TSPR Tell messages suppressed by remote client.
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This chapter shows you how to develop remote client executables using the .NET 
language C# and the graphical LabVIEW 8.5 programming environment. The 
Automated Test Application Remote Development Toolkit provides sample 
projects to enable you to experiment with the remote client development by 
starting with existing code. C# and LabVIEW implementations are provided.
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Simple Remote Client

The easiest way to begin is to start with the "Simple Remote Client" demo 
program.

1 On the computer, browse to the location where the toolkit is installed. In the 
desired "Source\C#\" subdirectory, locate the "SimpleRemoteClient" folder. It 
contains a C# implementation of the client. Copy this folder to another location 
on your computer so you can modify the copy without losing the original files.

2 Copy the Keysight.DigitalTestApps.Framework.Remote.dll application file (or 
Agilent.Infiniium.AppFW.Remote.dll, see "On the Client" in the Keysight 
DigitalTestApps Programming Getting Started guide) to the "distrib" directory 
in the new "SimpleRemoteClient" folder.

3 Using Visual Studio 2008 or newer, open the file "SimpleRemoteClient.sln".

4 In Visual Studio, display the properties page for the SimpleRemoteClient 
project and go to the "Debug" tab. Enter the IP address of the oscilloscope in 
the "Command line arguments field":

NOTE Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps 
only" subdirectories for guidance on the files to use for your remote client.
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Build and run. You should see output similar to this:
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You can also run this from the command line:

File description

These are the key folders and files in the project directory:

• SimpleRemoteClient.sln — Visual Studio solution file

• SimpleRemoteClient\

• SimpleRemoteClient.csproj — Visual Studio project file

• Program.cs — C# source file containing the entire program

• distrib\ — Directory where build outputs are copied to.

Source code description

Here is the function of each of the lines in the program:

1 This defines the namespace the program lives in:

namespace SimpleRemoteClient

2 This names the class the program lives in:

internal class Program

3 This is the method that gets executed when the program is run:

private static void Main(string[] args)

4 This establishes a connection to the application running on the oscilloscope:

Keysight.DigitalTestApps.Framework.Remote.IRemoteAte remoteAte =
Keysight.DigitalTestApps.Framework.Remote.RemoteAteUtilities.GetRemot
eAte(args[0]);

The "Keysight.DigitalTestApps.Framework.Remote." prefix indicates that 
IRemoteAte and RemoteAteUtilities are defined in the 
Keysight.DigitalTestApps.Framework.Remote.dll.

5 This sends a remote command to the oscilloscope to execute a property query 
in the automated test application:

string appName = remoteAte.ApplicationName;

This particular property contains the application's name. Please see Chapter 1, 
Chapter 1, “Keysight DigitalTestApps Remote Interface,” starting on page 9, for 
information on other properties and methods available in the automated test 
application's remote interface.
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6 This prints the result in the command window:

System.Console.WriteLine(appName + "\nPress any key to finish.");
System.Console.ReadKey();

The Simple Remote Client is intended for use as a remote programming learning 
and experimentation platform. For more realistic (and interesting) 
implementations, see the sections that follow.
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ARSL Command Line Utility Implementation

You may also examine the implementation for, modify, and build the ARSL 
Command Line Utility.

As with the Simple Remote Client, you will need to copy the file 
Keysight.DigitalTestApps.Framework.Remote.dll (or 
Agilent.Infiniium.AppFW.Remote.dll) to the distrib directory of the project.

Here are some of the differences from the Simple Remote Client:

• Design

This is more complex, so the implementation uses multiple components: the 
Program, a type to hold the runtime options, an argument parser and an Arsl 
executor as summarized in the diagram below:

NOTE Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps 
only" subdirectories for guidance on the files to use for your remote client.
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Notice that all of the interaction with the remote application is contained within 
the ArslExecutor.

• The ArslExecutor (ArslExecutor.cs) makes the connection to the remote 
application:



84 Keysight DigitalTestApps Programming Guide

5 Developing a Remote Client
 

internal void Initialize(string ipAddress, bool useCustomPort,
bool verbose)

{
if (useCustomPort)
{
GetRemoteAteOptions options = new GetRemoteAteOptions();
options.IpAddress = ipAddress;
options.UseCustomPort = true;
mRemoteAte = RemoteAteUtilities.GetRemoteAteCustom(options);
…

}
else
{
mRemoteAte = RemoteAteUtilities.GetRemoteAte(ipAddress);
…

}

…
}

• The ArslExecutor (ArslExecutor.cs) makes all the calls to the remote 
application. Even though the ARSL utility enables you to execute many different 
remote interface property and method actions, it only uses one member of the 
remote interface to accomplish this:

internal void ExecuteSingleCommand(string command)
{

string result = mRemoteAte.ExecuteArsl(command);
…

}

This particular method enables passing the utility a string representation of a 
property or method action and having it get executed as a real property or 
method action.

The rest of program is not specific to remote interface programming and is 
concerned only with parsing and validating the user input and generating the 
output.
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Simple GUI Remote Client Implementation

You may examine the implementation for, modify, and build the Simple GUI 
Remote Client.

As with the Simple Remote Client, you will need to copy the file 
Keysight.DigitalTestApps.Framework.Remote.dll (or 
Agilent.Infiniium.AppFW.Remote.dll) to the distrib directory of the project.

The design of this application is summarized in the diagram below.

NOTE Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps 
only" subdirectories for guidance on the files to use for your remote client.
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There are two primary design patterns in use: Observer and State. The Observer 
pattern leads us to place business logic (interaction with the remote application) in 
a separate module from the main dialog. The State pattern leads us to implement 
well-structured transitions as the user performs the various steps described in the 
main dialog.
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Here are some remote interface-related highlights from the code:

• The Model (Model.cs) configures the .NET Remoting Interface:

Internal void Initialize()
{

string path =
Path.getDirectoryName(Assembly.GetExecutingAssembly().Location);

string configFullPath =
Path.Combine(path,
"Keysight.DigitalTestAps.Framework.Remote.config");

RemotingConfiguration.Configure(configFullPath, false);
}

• The Model (Model.cs) makes the connection to the remote application:

internal void Connect(string ipAddress)
{

try
{
…
mRemoteAte = RemoteAteUtilities.GetRemoteAte(ipAddress);
mRemoteAte.Ping();

}
catch (Exception e)
{
MessageBox.Show("Could not connect to an application running at "

+ "IP Address: " + ipAddress + "\n\n" + "Reason: "
+ e.Message);

…
return;

}
}

The Ping method is called because the GetRemoteAte method will always 
return successfully, even if there is no application at the specified address, 
while Ping (and all the other properties and methods of the remote interface) 
can only work if the connection is valid.

• The Model (Model.cs) makes all other calls to the remote application

• Determining Available Tests

As mentioned in "Determine required tasks by first using the graphical user 
interface" on page 72, you may only execute a test via the remote interface 
if the automated test application is in such a state that the test is available 
on the "Select Tests" tab of the user interface. Fortunately, the remote 
interface provides a property that tells you exactly which tests are available 
at any given time. The Simple GUI Remote Client uses this to build the test 
list that it presents to the user. Again, in the Connect method:

internal void Connect(string ipAddress)
{

…
mAvailableTests = mRemoteAte.AvailableTests;

}
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This stores the test availability information in the model so it will be 
accessible by the dialog.

• Test execution

Tests are executed in the Run method (Model.cs) by setting the remote 
interface property 'SelectedTests' and calling the method 'Run':

internal void Run(int testIndex)
{

try
{
int[] testToSelect =

new int[] { mAvailableTests[testIndex].ID };
mRemoteAte.SelectedTests = testToSelect;
mRemoteAte.Run();
…

}
catch (Exception e)
{
MessageBox.Show("An error occurred during the run:\n\n" +

"Detail: " + e.Message);
}
…

}

• Result access

The result of the test is accessed in the Run method (Model.cs) by calling 
the remote interface GetResults method:

internal void Run(int testIndex)
{

…
ResultContainer results = mRemoteAte.GetResults();

// Remote Interface Versions 1.10 and prior (deprecated in 1.20)
:

//mWorstResult = results.WorstResults[0];

// Remote Interface Versions 1.20 and later only:
mWorstResult = results.ExtremeResults[0];
…

}

This returns a ResultContainer object which contains various details 
concerning the result.

The rest of program is not specific to remote interface programming and is 
concerned only with managing the graphical user interface.
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Simple Message Handling Remote Client Implementation

You may examine the implementation for, modify and build the Simple Message 
Handling Remote Client.

As with the Simple Remote Client, you will need to copy the file 
Keysight.DigitalTestApps.Framework.Remote.dll (or 
Agilent.Infiniium.AppFW.Remote.dll) to the distrib directory of the project. You will 
also need to copy this additional file: 
Keysight.DigitalTestApps.Framework.Remote.config (or 
Agilent.Infiniium.AppFW.Remote.config).

The design of this application is summarized in the diagram below:

Note that the model-view pattern is not used in this application in order to more 
clearly highlight the message-handling elements. All relevant code is in the file 
MainDialog.cs. Here are some remote interface-related highlights from the code:

• Initialization occurs when you click the "Connect" button:

private void btnConnect_Click(object sender, EventArgs e)
{

…
// Enable forward remote interface
// (remote client -> automated test app)
mRemoteAte = RemoteAteUtilities.GetRemoteAte(ipAddress);

NOTE Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps 
only" subdirectories for guidance on the files to use for your remote client.
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// Enable asynchronous callbacks
// (automated test app -> remote client)
// User must place the .config file in the same location as the
// remote client's .exe
string path =
Path.GetDirectoryName(Assembly.GetExecutingAssembly().Location);

string configFullPath =
Path.Combine(path, "Keysight.DigitalTestApps.Framework.Remote.con

fig");
RemotingConfiguration.Configure(configFullPath, false);
mAteEventSink =
RemoteAteUtilities.CreateAteEventSink(mRemoteAte, this,

ipAddress);
}

• The AteEventSink object is the key to managing callback activity. It has 
properties for specifying whether you want prompts issued by the automated 
test app to be:

• allowed to display on the scope

• transported to the remote client PC and displayed there

• never displayed (programmatically responded to by the remote client via an 
event handler)

private void chkRedirectMessages_CheckedChanged(
object sender, EventArgs e)

{
// Tell my AteEventSink to coordinate with app regarding message
// redirection
mAteEventSink.RedirectMessagesToClient =
chkRedirectMessages.Checked;

…
}
private void chkHandleSimpleCallbacksProgrammatically_CheckedChanged(

object sender, EventArgs e)
{

if (chkHandleSimpleCallbacksProgrammatically.Checked)
{
// Tell my AteEventSink to let me handle simple message callbacks
// from the app myself
mAteEventSink.SimpleMessageEvent +=

mAteEventSink_SimpleMessageHandler;
}
else
{
// Tell my AteEventSink to automatically handle (display) simple
// message callbacks from the app
mAteEventSink.SimpleMessageEvent -=

mAteEventSink_SimpleMessageHandler;
}

}

• To programmatically respond to a prompt from the automated test application, 
the event handler sets a property corresponding to the button on the prompt 
that is to be "clicked", for example "OK":
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private void mAteEventSink_SimpleMessageHandler(
object sender, MessageEventArgs e)

{
if (e.Message.Contains("completed")) // This is the prompt the app

// displays at the end of a run
{
e.Response = DialogResult.OK; // Be sure to respond using a

// DialgResult that is valid for the message being handled
return;

}
…

}

• At the start of a run, the demo program chooses which thread to make the 
request in:

• If no callbacks from the app can occur, the Run command may be safely 
executed in the main thread.

• If callbacks are enabled, the Run command must be executed in a worker 
thread. For more details, please see the "multithreading (see page 96)" 
discussion.

private void btnRun_Click(object sender, EventArgs e)
{

…
if (mAteEventSink.RedirectMessagesToClient)
{
…
// Must use worker thread to prevent deadlock when receiving
// asynchronous callbacks from app during a run
new Thread(mRemoteAte.Run).Start(); // This demo program will

// immediately proceed to the next line of code regardless
// of the state of the run

}
else
{
// No callbacks will be sent to the remote client, so it is
// safe to call Run() in the main thread
mRemoteAte.Run(); // This demo program will block at this line

// of code until the run is complete
}

}

• An automated test app will only allow one remote client to be registered to 
handle callbacks. Therefore, when the remote client exits it performs this 
cleanup action:

private void mRemoteClientClosing()
{

if (mAteEventSink != null)
{
// Tell my AteEventSink to notify the app that I am no longer
// the receiver for callbacks (so another remote client can
// register with the app)
mAteEventSink.Dispose();

}
}
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Message Handling Remote Client Implementation

You may examine the implementation for, modify and build the Message Handling 
Remote Client.

As with the Simple Remote Client, you will need to copy the file 
Keysight.DigitalTestApps.Framework.Remote.dll (or 
Agilent.Infiniium.AppFW.Remote.dll) to the distrib directory of the project. You will 
also need to copy this additional file: 
Keysight.DigitalTestApps.Framework.Remote.config.

The design of this application is summarized in the diagram below:

NOTE Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps 
only" subdirectories for guidance on the files to use for your remote client.
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There is one primary design pattern in use: Observer. The Observer pattern leads 
us to place business logic (interaction with the remote application) in a separate 
module from the main dialog.

Here are some remote interface-related highlights from the code:

• .NET Remoting
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The Model (Model.cs) configures the .NET Remoting Interface to enable the 
callback path (scope->client):

internal void Initialize(...)
{

string path =
Path.GetDirectoryName(Assembly.GetExecutingAssembly().Location);

string configFullPath =
Path.Combine(path, "Keysight.DigitalTestApps.Framework.Remote.Con

fig");
RemotingConfiguration.Configure(configFullPath, false);
...

}

• Groups and Namespaces

All of the controls in the "Core Features" group use remote interface members 
contained in the basic namespace, 
Keysight.DigitalTestApps.Framework.Remote:

• Run: mRemoteAte.Run();

• Suppress All Messages: mRemoteAte.SuppressMessages = value;

• Suppress Simple Messages: mRemoteAte.SuppressSimpleMessages = 
value;

• Suppress Data Input Messages: mRemoteAte.SuppressDataInputMessages= 
value;

• Connect Prompt Action: mRemoteAte.ConnectionPromptAction = value;

• Check Signal Prompt Action: mRemoteAte.SignalCheckFailAction= value;

All of the controls in the "Advanced" group use remote interface members 
contained in the advanced namespace, 
Keysight.DigitalTestApps.Framework.Remote.Advanced:

• Redirect Messages: mAteEventSink.RedirectMessagesToClient = value;

• Override Default Handler: mAteEventSink.SimpleMessageEvent += 
OnSimpleMessage;

• Event Sink

Both of the advanced features require the automated test application running 
on the oscilloscope to be able to call a function on the remote client. This is 
enabled by use of a class called "AteEventSink" (contained in the 
Keysight.DigitalTestApps.Framework.Remote.dll assembly). All the remote 
client has to do is instantiate an AteEventSink and keep it alive until the remote 
client closes:

NOTE The configuration file's contents are standard and may be used for any remote client requiring 
callback capability.
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mAteEventSink = RemoteAteUtilities.CreateAteEventSink(
mRemoteAte,
mMainDialog,
mIpAddress);

The event sink uses its constructor parameters to establish a two-way link 
between the remote client and the application running on the oscilloscope. It 
also exposes properties and events that enable the remote client to activate 
advanced communication features, such as:

• Redirecting dialogs to the client:

mAteEventSink.RedirectMessagesToClient = true;

This property tells the EventSink to configure the application running on the 
oscilloscope to send user messages to the EventSink instead of displaying 
them on the oscilloscope. Then the EventSink will use a default algorithm to 
display the message on the client.

• Overriding the default message handler:

mAteEventSink.SimpleMessageEvent += OnSimpleMessage;

This event enables the remote client to register a client-defined method for 
EventSink to use instead of its default algorithm. So, when 
RedirectMessagesToClient is set to true and a handler is subscribed to the 
SimpleMessageEvent event, the EventSink will forward on messages 
received from the application running on the oscilloscope to your client to 
do with as you please. In the example program, the client simply appends 
some text to the original message and displays it:

private void OnSimpleMessage(object sender, MessageEventArgs e)
{

e.Response = TellUser("Local handler processed this simple " +
"message:\n\n" + e.Message + "\n\nClick one of the " +
"buttons provided by the message sender:",
e.Buttons,
e.Icon,
e.DefaultButton);

}

• Mutlithreading

NOTE If you need to detect a certain message in order to perform a related task, you could examine 
the e.Message property for words that appear in the message. However, this approach is 
fragile because the application may change the message slightly over time. Instead, use the 
e.ID property, which is stable over time.
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Message redirection is a powerful capability, but it adds complexity to the 
design of the remote client. In particular, while message redirection is enabled, 
you run the risk of deadlock. Here are two such scenarios (remember, these 
apply only when message redirection is enabled):

a Executing a remote interface property action or method call in the GUI 
thread. When the client sets a property or calls a method in the automated 
test application's remote interface, if the remote action leads the automated 
test application to issue a redirectable message, then deadlock will ensue:

• The client's GUI thread is occupied waiting for the property action or 
method call to return. It will not process the incoming redirected 
message.

• The automated test application's GUI thread is occupied waiting for the 
redirected message to get answered.

To prevent this scenario, execute in a worker thread any remote interface 
property action or method call that may result in a redirected message.

b Updating the GUI directly from the remote interface. If you follow the design 
guideline from the previous step and execute remote actions from within a 
worker thread, you may still run into a similar deadlock situation. For 
example, consider this GUI code:

// GUI code
private void
chkRedirectMessagesToClient_CheckedChanged(object sender,
EventArgs e)
{

mModel.RedirectMessagesToClient =
chkRedirectMessagesToClient.Checked;

UpdateDialog();
}

private void UpdateDialog()
{

chkSuppresSimpleMessages.Checked =
mModel.SuppressSimpleMessages;

…
}

// Model code
public bool RedirectMessagesToClient
{

set { return mRemoteAte. RedirectMessagesToClient = value; }
}

public bool SuppressSimpleMessages
{

get { return mRemoteAte.SuppressSimpleMessages; }
}



Developing a Remote Client 5

Keysight DigitalTestApps Programming Guide 97

 

This sequence of events may lead to deadlock:

i If the application currently has a dialog displayed locally on the 
oscilloscope (for example "all tests completed").

ii On the remote client, the user clicks the RedirectMessagesToClient 
checkbox to enable this mode.

iii The callback code in chkRedirectMessagesToClient_CheckedChanged 
begins.

iv A RedirectMessagesToClient property set is sent to the automated test 
application and control returns to the client.

v The client begins its UpdateDialog method.

vi Asynchronously, the dialog that was being displayed on the oscilloscope 
at the beginning of this scenario is redirected to the client.

vii The client attempts to query the automated test application during 
UpdateDialog.

This would result in deadlock:

• The automated test application cannot respond to the client's query 
because it is busy waiting for a response from the client for the redirected 
message.

• The client will not display the redirected message because it is busy 
waiting for a response from the automated test application for the remote 
query.

To prevent this scenario, do not send remote commands to the automated 
test application while a redirected message needs attention on the remote 
client. In the above scenario, you would resolve the design problem by 
replacing the model's SuppressSimpleMessage getter implementation with 
one that caches the automated test application's state in a field and returns 
this field instead of querying the oscilloscope.

Here is actual message handling remote client implementation that 
demonstrates how design can avoid both of the above scenarios:

In MainDialog.cs:

// Define a delegate for a method that takes a single string
// parameter and returns void
private delegate void VoidStringDelegate(string s);

// Executed when the user clicks "Run"
private void btnRun_Click(object sender, EventArgs e)
{

…
// Call the Model's version of Run in a worker thread
VoidStringDelegate dlgtRun = mModel.Run;
dlgtRun.BeginInvoke(txtTestID.Text, null, null);
// BeginInvoke immediately returns even though the run is not
// completed.
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// Now the GUI is ready to handle any callbacks from the
// automated test application that may occur during the run.
…

}

In Model.cs:

internal void Run(string testId)
{

// Executing in a worker thread
…
mRemoteAte.RunTests(testId);
…

}

public bool SuppressSimpleMessages
{

get
{
// Return a field…don't query the oscilloscope
return mSuppressSimpleMessages;

}
set
{
mSuppressSimpleMessages = value;
mRemoteAte.SuppressSimpleMessages = mSuppressSimpleMessages;

}
}

• Disposal

To facilitate proper resource cleanup, always dispose of the event sink. The 
Model class (Model.cs) implements this using a standard pattern:

private bool mAlreadyDisposed;

public void Dispose()
{

Dispose(true);
GC.SuppressFinalize(this);

}

~Model()
{

Dispose(false);
}

protected virtual void Dispose(bool isDisposing) {
if (mAlreadyDisposed)
{
return;

}

if (isDisposing)
{
mAteEventSink.Dispose();

}
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mAlreadyDisposed = true;
}
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LabVIEW Simple Remote Client

This section describes how to create your own remote client using the LabVIEW 
programming environment. In addition to requiring the 
Keysight.DigitalTestApps.Framework.Remote.dll file ( (or 
Agilent.Infiniium.AppFW.Remote.dll, see "On the Client" in the Keysight 
DigitalTestApps Programming Getting Started guide for a list of minimum 
requirements), LabVIEW clients use an interface adapter assembly, 
"Keysight.DigitalTestApps.RemoteTestClient.dll" (or 
Agilent.Infiniium.RemoteTestClient.dll). This file is also provided in this Toolkit in 
the desired Tools\LabVIEW\LabVIEW Remote Adapter subdirectory.

1 Create a new folder in C:\Labview.

2 Copy the following files to the folder created:

a Keysight.DigitalTestApps.Framework.Remote.dll (or 
Agilent.Infiniium.AppFW.Remote.dll, see "On the Client" in the Keysight 
DigitalTestApps Programming Getting Started guide).

b On the computer, browse to the location where the toolkit is installed.

From the desired "Tools\LabVIEW\LabVIEW Remote Adapter" subdirectory 
copy Keysight.DigitalTestApps.RemoteTestClient.dll (or 
Agilent.Infiniium.RemoteTestClient.dll) and 
Keysight.DigitalTestApps.RemoteTestClient.dll.config (or 
Agilent.Infiniium.RemoteTestClient.dll.config).

3 Launch Labview and create an empty project.

NOTE Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps 
only" subdirectories for guidance on the files to use for your remote client.

NOTE Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps 
only" subdirectories for guidance on the files to use for your remote client.
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 4 Add the following files to the project:

a Keysight.DigitalTestApps.Framework.Remote.dll

b Keysight.DigitalTestApps.RemoteTestClient.dll
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5 Add a new VI to the project.

6 Add a Constructor node to the Block Diagram of the VI and select the 
RemoteClient (String ApplicationPath) constructor from the 
Keysight.DigitalTestApps.RemoteTestClient.dll (or 
Agilent.Infiniium.RemoteTestClient.dll).
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7 Add a string constant and link it to the constructor created earlier. The string 
constant value must be pointing to the directory where 
Keysight.DigitalTestApps.RemoteTestClient.dll.config (or 
Agilent.Infiniium.RemoteTestClient.dll.config) is located. In the case of this 
example it will be in C:\Labview as it copied there in step 1).

8 Add a While Loop node to the block diagram of the VI.
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9 Add a Event Structure node into the While Loop node added in step 8.

10 Add an Ok Button to the Front Panel. Rename the button label to "Connect".
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11 Edit the Timeout event in the Block Diagram to wait for a Mouse Down on the 
newly added Connect button.
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12 Add a Invoke node and select the Connect(String IP) method. Create a string 
constant with the IP of the scope where the automated test application is 
running.
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13 Create the following interface on the Front Panel using:

a One Ok Button

b One String Control

c One String Indicator
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14 Add an event for the Execute ARSL button as you did for the Connect button.
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15 Add an Invoke node to the block diagram and select the Execute ARSL method.

16 Link the ARSL Command and ARSL Output nodes to the ExecuteARSL node as 
shown below.
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17 Add a False Constant node and link it to the While node Loop Condition as 
shown below.

18 Bring up the Front Panel VI and run it to test this example. Click on the Connect 
button and enter into the ARSL Command text "Available Tests?" minus the 
quotes. Click on the Execute ARSL button once the command has been entered.
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19 If the connection and execution was successful, the list of available tests should 
be displayed in the ARSL Output Indicator.



112 Keysight DigitalTestApps Programming Guide

5 Developing a Remote Client
 

LabVIEW Demo Client Construction

This section describes how to create your own remote client using the LabVIEW 
programming environment. In addition to requiring the 
Keysight.DigitalTestApps.Framework.Remote.dll file (or 
Agilent.Infiniium.AppFW.Remote.dll, see "On the Client" in the Keysight 
DigitalTestApps Programming Getting Started guide for a list of minimum 
requirements), LabVIEW clients use an interface adapter assembly, 
"Keysight.DigitalTestApps.RemoteTestClient.dll" (or 
Agilent.Infiniium.RemoteTestClient.dll). This file is also provided in this Toolkit in 
the desired Tools\LabVIEW\LabVIEW Remote Adapter subdirectory.

The following topics describe how to create your own remote LabVIEW client. For 
a detailed description of the remote API for LabVIEW, see the documents 
described in "Remote Interface Documentation" on page 10.

Creating a Remote Client

Insert a .Net Constructor node from the menu selection. Select 
RemoteClient(string) constructor from 
Keysight.DigitalTestApps.RemoteTestClient.dll (or 
Agilent.Infiniium.RemoteTestClient.dll). Supply to the constructor the application 
path which is a String.

NOTE Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps 
only" subdirectories for guidance on the files to use for your remote client.

NOTE In order to import and use the Keysight.DigitalTestApps.RemoteTestClient.dll (or 
Agilent.Infiniium.RemoteTestClient.dll), all vi's that reference or use the dll need to be part of a 
Labview project. Once a project has been created, add a new or existing vi to it so the 
Keysight.DigitalTestApps.RemoteTestClient.dll (or Agilent.Infiniium.RemoteTestClient.dll) can 
be referenced correctly.

Figure 1 Remote Client Constructor
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Registering an Event

Insert a .Net Register Event Callback node from the menu selection. There are 
three events available for registration:

1 DataInputEvent.

2 TestListEvent.

3 SimpleMessageEvent.

Select which event to register to from the drop down, and create a callback vi.

TestList Event

The TestListChangedEventArgs parameter is passed during the TestListEvent. The 
example above shows how the values in a List box are updated with the names of 
the Available Tests. Please refer to Keysight DigitalTestApps Remote Interface for 
LabVIEW help file for more details on the TestListChangedEventArgs properties.

Figure 2 Registering an Event

Figure 3 TestList Changed Event
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SimpleMessage Event

The MessageEventArgs parameter is passed during the SimpleMessageEvent. The 
example above shows how a single "OK" button message is handled. Different 
messages may have different expected return values. Please refer to the Keysight 
DigitalTestApps Remote Interface for LabVIEW help file for more details on the 
MessageEventArgs properties.

DataInput Event

The MessageEventArgs parameter is passed during the DataInputEvent. The 
example above shows a MessageEventArgs being passed to the Inputprompt.vi for 
user input. When the user has entered the data and clicked the "OK" button, the 
response will be sent back to the application.

Figure 4 SimpleMessage Event

Figure 5 DataInput Event
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Different messages may have different expected return values. Please refer to the 
Keysight DigitalTestApps Remote Interface for LabVIEW help file for more details 
on the MessageEventArgs properties.

Loading a Project

Insert an Invoke node from the menu and select "SetLoadProjFullPath(String)" as 
the method. Supply the method the full path with the project name.

Invoke "LoadProjectCustom" once the project full path has been supplied.

Discarding Unsaved Changes

To discard unsaved changes when loading a project, invoke the 
"SetDiscardProjChanges(bool)" before invoking the "LoadProjectCustom" method.

Figure 6 Loading a Project Part A

Figure 7 Loading a Project Part B

Figure 8 Discard Unsaved Changes
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Saving a Project

Insert an Invoke node from the menu and select "SetSaveProjName(string)" as the 
method. Supply the method the full path with the project name.

Invoke "SaveProjectCustom" once the full path has been supplied.

Figure 9 Saving a Project Part A

Figure 10 Saving a Project Part B
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Setting a Config

The example above shows how to Set a Configuration value. Insert an Invoke node 
from the menu and select SetConfig(string,string) as the method. Supply the 
Variable Name and Variable Value to set the configuration.

Overwriting an Existing Project

To overwrite an existing project during a save, invoke "SetSaveOverwriteProj(bool)" 
method with a Boolean value before invoking the "SaveProjectCustom" method.

Getting a Config

Figure 11 Setting a Configuration

Figure 12 Overwrite an Existing Project

Figure 13 Getting a Configuration Value
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The example above shows how to Get a Configuration value. Insert an Invoke node 
from the menu and select GetConfig(string) as the method. Supply the Variable 
Name to get the value for that variable.

Connection Prompt Action

When manual connection changes are required by the remote application, the user 
will be prompted. To select the response to these connection change prompts, 
invoke "SetConnectionPromptAction(String)" method with either "AutoRespond", 
"Display", or "Abort".

Signal Check Fail Action

Certain applications perform a series of checks before running a test to ensure that 
the signal provided is correct. In cases where the signal provided does not meet 
the criteria, a prompt will occur. To select the response to these connection 
change prompts, invoke "SetSignalCheckFailAction(String)" method with either 
"AutoRespond", "Display", or "Abort".

Running Tests

Figure 14 Connection Prompt Action

Figure 15 Signal Check Fail Action

Figure 16 Running Tests Part A
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The example above shows how to run a set of tests. Insert an Invoke node from the 
menu and select TestNameToID(string) as the method. Supply the test name to 
the method and the corresponding TestID will be returned. Pass the array of 
TestIDs to the "SetSelectedTests()" function.

After that, invoke "RunCustom()" to execute the tests.

Increasing Number of Trials

The above example shows how to increase the number of trials to run each time 
the tests are executed (as well as the number of trials that are retrieved when 
obtaining results). Invoke the "SetStopConditionCount(int Trials)" method and set 
it to the number of trials each test is to be executed. Invoke 
"SetResultOpsMaxTrial(int Count)" to set the number of trials results to return. 
Note that when more than one trial is selected, the Test Plan feature is disabled 
(and the LabVIEW interface is updated).

Figure 17 Running Tests Part B

Figure 18 Increasing number of trials
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Enabling Test Plan Feature

The above example shows how to enable the Test Plan feature. The feature is only 
available if the remote application supports it. Invoke the 
"SetTestPlanEnabled(bool Status)" method and pass it a boolean value.

Skipping Completed Permutations

The example above shows how to the application can be made to skip completed 
permutations in the Test Plan feature. Invoke the "SetTestPlanSkipPermu(bool 
status)" method and pass it a Boolean value.

Execute ARSL

The example above shows how to execute an ARSL command. Insert an Invoke 
node from the menu and select ExecuteARSL(string) as the method. Supply the 
ARSL command string to the method which will return the Status/Value as a 
String.

Figure 19 Enable Test Plans

Figure 20 Skipping Test Plan Completed Permutations

Figure 21 Executing ARSL Commands
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Connect

The example above shows how to connect to the automated test application. 
Insert an Invoke node from the menu, and select Connect(string) as the method. 
Supply the IP address of the oscilloscope where the automated test application is 
running.

Appending/Replacing Test Results

The user is given a choice to either replace the test results of previous runs with 
the new run or append the previous test results with the new run. To do so, invoke 
the "SetExistingResultsAction" method with either "Replace" or "Append" as the 
parameter.

Getting Results

Figure 22 Connecting to the Application

Figure 23 Appending/Replacing Test Results

Figure 24 Getting Results Part A
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The example above shows how to get test results for selected tests from the 
listbox. First, get the selected test names from the list box and pass them to the 
"TestNametoID" method to get the Test IDs. Next, pass the list of Test IDs to the 
"SetResultOpsTestIDs" method.

Invoke "GetResultsCustom" which will return a "ResultContainer" object that has 
the property "WorstResults". The "WorstResults" property contains several details 
for the test results. Please refer to the Keysight DigitalTestApps Remote Interface 
for LabVIEW help file for more details on the various properties used by the 
Results.

Delete Results

The example above shows how to delete the results for all tests. Insert an Invoke 
node and select DeleteResults().

Figure 25 Getting Results Part B

Figure 26 Deleting Results
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Refreshing the Test List

The example above shows how to get the list of available tests. Insert an Invoke 
node and select GetAvailableTestList(). It will return an array of TestInfo objects. 
From the array of tests, extract the names of the tests to populate in the list box. 
Please refer to Keysight DigitalTestApps Remote Interface for LabVIEW help file.

Updating Your Automated Test Application

From time to time, automated test application updates are released. When this 
occurs, the associated remote interface version may be different as well (for 
example, in order to provide new functionality). Recall that you can use the ARSL 
Command Line Utility (see "ARSL Command Line Utility" on page 16) to quickly 
determine the remote interface version used by an application. If it has changed, 
you need to update these two files in your LabVIEW directory in order to use the 
new functionality:

1 Keysight.DigitalTestApps.Framework.Remote.dll (or 
Agilent.Infiniium.AppFW.Remote.dll)

2 Keysight.DigitalTestApps.RemoteTestClient.dll (or 
Agilent.Infiniium.RemoteTestClient.dll)

For more information, see Chapter 2, “Using Sample Remote Clients,” starting on 
page 15.

Use the following steps to update these files in your LabVIEW project:

1 Remove all copies of the dlls from C:\LabView and any subfolders within them.

2 Place the new copies of the dlls in C:\LabView.

3 Launch the example as described in "LabVIEW Demo Remote Client" on 
page 29. If you receive the following prompt during the update, click OK to 
proceed:

Figure 27 Getting Available Tests
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4 Open each of the sub-VIs that are marked in the red boxes and resave them.

5 Save the main VI

6 Save the project and exit.
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The best place to start when troubleshooting remote interface difficulties is to 
verify the machine running the automated test application (oscilloscope or PC) is 
set up properly. The easiest way to do this is to run the ARSL command line utility 
on the remote computer and see if you can send the remote query 
"ApplicationName?" to the automated test application. See "ARSL Command Line 
Utility" on page 16 for instructions on using this utility.



126 Keysight DigitalTestApps Programming Guide

6 Troubleshooting
 

How to Manage the App Migration to Keysight

Agilent's Electronic Measurement business is now Keysight Technologies, Inc., so 
automated test apps branded as Agilent are being migrated to Keysight. Which 
documents and remote support assemblies you need to use to develop your 
remote client depends upon how long you need to control Agilent-branded apps. 
There are now two sets of remote interface artifacts:

• Transition (compatible with Agilent or Keysight apps): Pease see the readme.txt 
document in the "Agilent-Keysight Transition" subfolder.

• Keysight-Only (compatible only with Keysight apps): Please see the readme.txt 
document in the "Keysight Apps Only" subfolder.
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Error Messages and Resolution

Here are some common error messages and resolution steps:

Could not load file or assembly 
'Keysight.DigitalTestApps.Framework.Remote'

Check:

1 Ensure a copy of the file Keysight.DigitalTestApps.Framework.Remote.dll is 
placed in the same directory as the remote client executable (see "On the 
Client" in the Keysight DigitalTestApps Programming Getting Started guide).

The remote interface of the target application has been disabled by local 
user

Check:

1 The automated test application running on the target machine (oscilloscope or 
PC) must have its remote interface enabled (see View->Preferences::Remote tab). 
Another user may have manually disabled the remote interface to protect a 
critical and/or long-duration test running on the target machine from being 
accidentally interrupted by a remote user.

A connection attempt failed because the connected party did not properly 
respond after a period of time, or established connection failed because 
connected host has failed to respond

Check:

1 The Windows Firewall on the machine running the automated test application 
must have these port exceptions defined (this is automatically taken care of 
during the automated test app's installation):

Legacy (Agilent) apps require ports 9944 and 49944
Keysight apps require ports 49944 and 59944
Various names may exist for these exceptions (differences

are unimportant).

The network address is invalid, No connection could be made because the 
target machine actively refused it

Check:

1 The IP address you provided should be the address of the target machine 
running the automated test application (oscilloscope or PC). Ensure the remote 
client computer can see this machine.

2 A remote-capable automated test application must be installed and running on 
the target machine.
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3 (Real-time 9xxx and 9xxxx Series Infiniium versions 3.19 and older only, Remote 
Interface versions 1.90 and older only) An automated test application remote 
control license must be installed on the oscilloscope. You can verify by 
checking the Infiniium Help>About Infiniium dialog and looking for the name "App 
Remote" in the list of installed options.

4 The automated test application must have activated a remote interface network 
port (for instructions, see "How to Check Which Port an Application is Using" 
on page 130). If it activated a user-defined port, you must access the 
application using the helper method 
RemoteAteUtilities.GetRemoteAteCustom() with option UseCustomPort set to 
true. The helper method RemoteAteUtilities.GetRemoteAte() can only access 
applications via the two standard ports.

The target application did not respond

Do the following::

1 Close the automated test application.

2 Configure a user-defined remote interface port on the target machine (for 
instructions, see "How to Configure a Remote Interface User Port" on 
page 132).

3 Restart the automated test application and verify it has enabled its remote 
interface (for instructions, see "How to Check Which Port an Application is 
Using" on page 130).

4 In your remote client, access the automated test application using the helper 
method RemoteAteUtilities.GetRemoteAteCustom() with option 
UseCustomPort set to true.

The target machine has an invalid user port entry

Check:

1 When using RemoteAteUtilities.GetRemoteAteCustom() with option 
UseCustomPort set to true, the target machine running the automated test 
application must have a user-defined remote interface port (for instructions, 
see "How to Configure a Remote Interface User Port" on page 132).

Method not found

Check:

1 The client found a remote-capable automated test application running on the 
target machine (oscilloscope or PC), but the remote interface property or 
method you attempted to use was not supported by the application. Ensure the 
property or method is supported in the version of the remote interface version 
used by the application. The version can be found in the application's 
Help>About dialog (if it is not there, the version is prior to 1.20). Then check the 
help file Keysight DigitalTestApps Remote Interface for .NET.chm (see "Remote 
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Interface Documentation" on page 10): each property and method is also 
annotated with the versions it is supported in.

2 Please visit: "www.keysight.com/find/scope-apps" to see if there is a newer 
version of your automated test application available for download from 
Keysight Technologies.

http://www.keysight.com/find/scope-apps
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How to Check Which Port an Application is Using

In the automated test application running on the target machine (oscilloscope or 
PC), open the View >Preferences dialog. On the Remote tab, in the Network Port 
Status group, the port being used by the remote interface subsystem will be 
marked "Active". If no user-defined remote interface port has been set on the 
target machine, then when the application launches it will attempt to activate one 
of the two standard ports:

If a user-defined remote interface port (5000 in the example below) has been 
defined on the target machine, then when the application launches it will attempt 
to activate it first:
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For more information, see "How to Configure a Remote Interface User Port" on 
page 132.

NOTE When you use the ARSL command line utility –up option, it will connect to the automated test 
app using RemoteAteUtilities.GetRemoteAteCustom() with option UseCustomPort set to true 
to. See "ARSL Command Line Utility" on page 16 for instructions on using this utility.
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How to Configure a Remote Interface User Port

1 Identify an available network port on the target machine.

On the target machine, in a command window enter: netstat -aon (the letter 
o, not the number 0). The resulting output lists ports currently in use on that 
machine. In the TCP section, look for a port number in between 49152 and 
65535 that does not appear in the list. In the example below, you could select 
any number from that range because none of them are in use:

2 On the target machine, add a string value named "RemoteInterfacePort" to 
registry key.

For Agilent apps:

• (Windows XP) HKEY_LOCAL_MACHINE\SOFTWARE\Keysight\Infinium\
Apps

• (Windows 7) HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\
Keysight\Infinium\Apps

For Keysight apps:

• *(Windows 7) HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\
Agilent\Infinium\Apps

or

• (Windows 7) HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\
Keysight\DigitalTestApps

Then assign the value of the port number you chose above to 
RemoteInterfacePort.

* This legacy registry key will be supported by Keysight apps until August 1, 
2016. For more information on the migration of apps from Agilent to Keysight, 
please see "How to Manage the App Migration to Keysight" on page 126.
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3 On the target machine, add a TCP port rule/exception (for the port number you 
chose above) to the Windows Firewall.

4 On the target machine, ensure the "Remote Registry" service is running.

NOTE When you use the ARSL command line utility –up option, it will connect to the automated test 
app using RemoteAteUtilities.GetRemoteAteCustom() with option UseCustomPort set to true 
to. See "ARSL Command Line Utility" on page 16 for instructions on using this utility.
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If your PC Has Two Network Interface Cards

The remote interface uses Microsoft .NET Remoting technology. When a remote 
client (optionally) activates the callback path (see 
"Keysight.DigitalTestApps.Framework.Remote.Advanced" on page 12), .NET 
Remoting by default uses the IP address of the primary NIC configured in the 
client's operating system.

You have three options:

• Use the RemoteAteUtilities.CreateAteEventSinkCustom method, which 
will automatically select a NIC that is on the same subnet as the automated 
test application you are controlling. For more information on configuring the 
callback path, see "Message Handling Remote Client Implementation" on 
page 92. For more information on the CreateAteEventSinkCustom method, 
see the help file: Keysight DigitalTestApps Remote Interface for .NET.

-OR-

• Add this property to your client's 
Keysight.DigitalTestApps.Framework.Remote.config file to tell .NET Remoting 
to use your private network IP address for compliance app callbacks:

<channel ref="tcp" name="ATECallbackTCP" port="49946" machineName="19
6.168.0.2">

-OR-

• Make the required NIC primary. Here is a website that describes how to assign 
which NIC on your client is considered by the OS to be primary:

"http://theregime.wordpress.com/2008/03/04/how-to-setview-the-nic-bind-
order-in-windows/"

NOTE Replace "196.168.0.2" with your actual network IP address.

http://theregime.wordpress.com/2008/03/04/how-to-setview-the-nic-bind-order-in-windows/
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How To Test Two-way .NET Remoting Between Your PC and Your 
Scope

The remote interface uses Microsoft .NET Remoting technology. Included in this 
toolkit are a pair of sample client and server applications that exercise a 
bi-directional .NET Remoting interface. You may use these apps to verify .NET 
Remoting is working between your remote client PC and your oscilloscope.

1 Copy the Miscellaneous\Tools\C#\Dot Net Remoting Server\ folder to your 
oscilloscope desktop.

2 Copy the Miscellaneous\Tools\C#\Dot Net Remoting Cl ient\ folder to your remote 
client PC desktop.

3 On the oscilloscope:

a (Optional) Edit the DotNetRemotingServer.exe.config file to use a different 
network port.

b Run DotNetRemotingServer.exe. The following screen will display:

When the server receives commands from the Dot Net Remoting Client, the 
server will display them in the command history listbox. Use the Clear button 
to clear this list at any time.

The Generate Event button enables you to manually initiate a single callback 
event. If the Dot Net Remoting Client is subscribed to receive callbacks, then 
the client will receive a message from the server and acknowledge it in the 
client's user interface.

4 On the remote client PC, run DotNetRemotingClient.exe. The following screen will 
display:

NOTE The source code for both of these applications may be found in the Miscellaneous\Source\
C#\ directory.
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5 Enter the IP Address of the scope the DotNetRemotingServer application is 
running on.

6 Select a port that matches the value found in the 
DotNetRemotingServer.exe.config file on the scope.

When you install any Keysight automated test application on your oscilloscope, 
it opens up ports 49944 and 59944 in the firewall (These are the primary and 
alternate ports a remote client will automatically try when connecting to one of 
those applications.) If you select any other port, ensure that port is opened in 
the scope's firewall.

7 Click Connect. If successful, the rest of the controls will become available and a 
"Ping" command will be sent to the server. The server will acknowledge 
receiving commands from the client in the server's user interface.

Use the Run and Stop buttons to send a command to the server to make it start 
and stop running its test program. This program is a simple loop that generates 
callback events once-per-second, which the server sends to the client if the 
client is subscribed to receive them.

Use the Subscribe and Unsubscribe buttons to cause the client to 
register/unregister to receive callback events from the server. When the client 
receives callback messages from the Dot Net Remoting Server, the client will 
show them in the callback history listbox.

Use the Clear button to clear this list at any time.
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